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  About This Document…

Welcome to Rensselaer!

Here at Rensselaer, computing plays a major role in the everyday educational experience, and students and faculty alike have access to a broad range of computing tools for their coursework.  You'll find that many courses use computing extensively in their curricula.  You'll also use computing as a tool to access library collections and services for coursework and other information needs.

But there are so many new things to try to remember!

Don't panic!  In fact, relax.  Academic Computing Services (ACS) has tried to anticipate as many of your questions as we possibly could, and has put together this document in hopes of answering them.  **

· The first section of this document will help you start using your recently acquired laptop computer.

· The remaining sections provide general information about computing here at Rensselaer

Therefore, please hang on to this user's guide!  We think you'll find it to be a useful source of information to which you can return again and again.





The Staff of Computing & Information Services      
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The information in this document was current as of August 13, 1999.
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  Introducing Your Laptop


Unpacking the Box

The laptop computer you've just received is an IBM ThinkPad 600E Model 2645-4AU.  As you unpack the box, please take a few minutes to make sure you have -- and hang onto -- the materials listed below.  Also make sure you keep the separate sheet you received that has your RCS userID and password.

Materials to Keep

· Power cord and adapter

· Network card in a box

· Network cable

· Floppy drive

· Bag containing trackpoint caps, a phone cord, and a plastic slimbay protector

· Microsoft Windows 98 User Guide (product key is on the front cover)

· IBM User Reference Manual

· IBM ThinkPad 600E MT 2645 Product Recovery and Software Selections CDs

· Lotus SmartSuite CD

· Getting Service pamphlet

· User Reference Supplement and User Reference Setup Guide Supplement pamphlets

· Setup Guide


Please remember to complete, sign, and return 
the configuration/installation checklist 
that you received with your laptop.

Hardware Features

Front View
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1. The color LCD screen displays computer output.

2. The brightness control adjusts the brightness of the display. The contrast control adjusts the contrast of the display.

3. The built-in microphone captures sound and voice when it is used with an application program capable of handling audio.  

4. The PC Card eject buttons eject the PC Card from the PC Card slots.

5. The PC Card slots accept PC Cards.

6. The infrared port allows the computer to communicate with other devices that have 
infrared data-transfer capability.

7. The headphone jack, a 3.5mm diameter jack, is where you connect a stereo headphone or external speakers.

8. The microphone/line-in jack, a 3.5mm diameter jack, allows you to connect a stereo microphone or an external audio device.

9. The external diskette drive connector allows you to connect the cable of the external diskette drive.

10. The LCD latch opens the LCD when pressed.

11. The diskette-eject button ejects the diskette from the diskette drive.

12. The diskette-drive is the drive for the UltraslimBay.

13. The TrackPoint buttons work with the TrackPoint stick (17) and provide a function similar to that of a mouse button.

14. The hard disk drive is the computer’s built-in hard disk drive.

15. The Fn key is used with the function keys to activate the Fn key functions.

16. The left and right internal speakers generate stereo sound.

17. The TrackPoint stick is a built-in pointing device that provides a function similar to that of a mouse.

18. The system-status indicators consist of indicators light and their associated symbols.

19. The external diskette drive allows you to use a floppy disk if another device is in the UltraslimBay.

20. The emergency hole allows you to eject the CD-ROM tray if it does not open with the eject button. (22)

21. The CD-ROM eject button ejects the CD-ROM tray.

22. The CD-ROM access indicator is on when data is being read from a CD-ROM in the CD-ROM drive.
23. The CD-ROM drive is the drive for the UltraslimBay.

Rear View
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1. The security keyhole is used with a mechanical lock.

2. The modem connector is used for connecting your computer to a telephone line.

3. The power switch turns the computer on and off.

4. The reset switch is used to turn the computer off if an application hangs or if the computer will not accept any input. Use the tip of a pen to press this switch.

5. The universal serial bus (USB) connector allows you to connect any device that conforms to this new interface.  Many recent digital devices comply with this new standard.

6. The power jack allows you to connect the AC Adapter cable.

7. The serial connector allows you to connect a 9-pin, serial device cable.

8. The system-expansion connector (240-pin) allows you to connect the port replicator or docking station.

9. The parallel connector allows you to connect a parallel printer cable.

10. The external-monitor connector allows you to attach an external monitor.

11. The external-input-device connector allows you to attach a mouse, external keyboard, or external numeric keypad to the computer.  To use more than one device -- for example a keypad and a mouse -- connect the keypad cable to the computer and the mouse cable to the back of the keypad.  You will need to purchase a keyboard/mouse cable if you wish to use both a keyboard and mouse with your laptop.

Bottom View
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1. The UltraslimBay device lock is a lock for the device in the UltraslimBay.

2. When the bay LED is on, the system is in use. Do not remove a bay device.

3. The memory-slot cover covers the memory slot.

4. The memory slot accepts an SDRAM (static dynamic random access memory) dual inline memory module (DIMM) option.

5. The battery-pack latch locks or releases the battery pack.

6. Put your name plate here.

7. To remove the hard disk, loosen this hard disk screw. You can use the security screw shipped with your computer as a hard disk screw.

8. The battery pack is a built-in power source for the computer.

Setting Up the Laptop

Opening the Machine

There are two small spring-loaded latches (LCD latches, labeled as #10 on the front view on page 4) located on either side toward the front of the machine.  Use your index fingers to push these two switches forward (toward you), then, still holding the switches forward, use your thumbs to push up the lid of the laptop.

Connecting the Pieces

Connecting the Power Cord

To connect the power cord, insert the three-pronged "jack" end of the power cord into the matching receptacle of the AC adapter, then plug the other end into a standard electrical outlet.  Insert the yellow-coded plug on the AC adapter cord into the matching yellow-coded power jack (labeled as #6 on the rear view on page 5) located on the back of the laptop.

Connecting the Floppy Disk Drive

To connect the floppy disk drive to the laptop, first make sure the wider edge of the external disk drive connector is facing up, then insert the connector to the external disk drive port (labeled as #9 on the front view on page 4) located on the right side of the machine.  The connector should click into place.  DO NOT FORCE IT.  (To remove the connector, squeeze in the two small tabs on either side of the connector head.)

Do not install the network card at this time.

Powering on the Laptop

Open the laptop if you have not already done so.  To power on the laptop, push the power switch located on the left side of the machine (labeled as #3 on the rear view on page 5) away from you, then release it.

Entering the Required Information

When the laptop has powered up completely, a Windows 98 Setup Wizard window will appear.  You must enter your name in the Name: field, but you may leave the Company: field blank.  Click the Next button at the bottom of the window.

A License Agreement window will appear.  After you have read the terms of the agreement, select the option saying that you accept the terms of the agreement, and click the Next button to accept those terms.

A Product Key window will appear.  Enter the product key, exactly as it appears on the cover of your Getting Started with Microsoft Windows 98 User Guide, in the fields provided.  (You don't have to use the Tab key; the cursor will automatically move from field to field as you type.)  Double-check what you have typed to make sure you have entered the product key correctly, then click the Next button.

A Start Wizard window appears.  Click on the Finish button to continue starting Windows 98.

A Supply Rensselaer Credentials window appears.  Enter your assigned RCS userID (exactly as it appears on your account sheet) in the top field, and the name of your dorm building as your workgroup name.  (The system will require you to enter a workgroup.)  Off-campus users should enter offcampus as their workgroup name.

Click the OK button.

THE LAPTOP WILL NOW AUTOMATICALLY SHUT DOWN.

Connecting to the Network

Installing the Ethernet Card

With the words "IBM EtherJet" facing up on the card, and with the small triangular black arrow pointing in toward the machine, insert the network card in the bottom card slot (labeled as #5 on the front view on page 4).  Next, with the printed side of the connector facing up, connect the short Ethernet card connector cable to the port located directly on the Ethernet card.

Insert one end of the network cable into the receptacle on the end of the Ethernet card connector cable, and the other end of the network cable into a laptop jack.  Check to make sure the small green light on the connector cable is lit to make sure the port is working correctly.

Power on the machine.

Connecting to the Network and Obtaining Your Adapter Address

When the machine finishes booting, the system will prompt you to enter your RCS userID and password in the appropriate fields.  The system will then prompt you to confirm your password by entering it again.

The Welcome to Windows 98 window will appear.  At this point, click the Close ("X") icon in the upper right corner of the window to close it. (Clicking on the Continue option would start up a guided tour of Windows 98, but please don't do this now.  However, you should go back and go through this guided tour later.)

Open the Start Menu in the lower left corner of the screen, and select the Run… option.  If the winipcfg command doesn't appear by default in the window that comes up on the screen, type it in to check the machine's window IP configuration, and click OK.

An IP Configuration window appears.  If the adapter is listed as PPP Adapter in the top field of the window, click on the small drop-down arrow beside that field and select the IBM 10/100 EtherJet CardBus Adapter option.  When you do this, the remaining IP Address, Subnet Mask, and Default Gateway info will appear in the appropriate fields 

Write down the machine's adapter address (shown in the Adapter Address field) in the appropriate field provided at the bottom of page 2 of this document, as well as on your Laptop Configuration/Installation Checklist.

You should now be connected to the network.

Software Features

An Overview of the Included Software

Your laptop has come pre-loaded with a number of software packages, including:

· Microsoft Office 2000 Professional-- Microsoft's Office suite of Word, Excel, Access, and PowerPoint packages will provide you with word processing, spreadsheet, database, and presentation capabilities, respectively.

· Maple V -- This symbolic algebra package allows you to integrate, differentiate, solve equations, and plot functions.

· SecureCRT -- This package provides a secure connection to the RCS UNIX systems.

· Microsoft Visual C++ -- This package provides a C++ programming/development environment from Microsoft.  The rest of the Visual Studio package, including Front Page 2000, J++, FoxPro, and Visual Basic, is available on CD ROM at the VCC Help Desk.

· LabVIEW -- LabVIEW provides data acquisitions and control, data analysis, and data presentation capabilities.  Please note that only sub-sets of this package have been pre-installed on your machine; you can obtain the remaining components on CD from the VCC Help Desk.

· Norton Anti-Virus -- This software helps protect your laptop against possible virus contamination and related problems.

A Brief Description of Your Laptop's Disk Drive

Your laptop's disk drive consists of one main partition that is divided into three logical drives, as described below:

C:\
Your laptop's C drive contains all of the system files and the machine's Windows 98 CAB files. This partition is formatted as FAT 16, and is 2GB in size.

D:\
This drive contains the data files and is the suggested location for storing your personal files.  This is also the recommended partition in which to install any additional software.  This partition is formatted as FAT 32 to maximize disk space, and is 2.5GB in size.

E:\
This drive is available to use as you wish; for example, you can use this space to install Linux.  You can also use it to store your personal files.  Like the D drive, this partition is formatted as FAT 32, but is 1.5GB in size.

Test-Driving Your New Laptop

Understanding Some Basic Terms
Active Window – Refers to the window in which you're currently working.  The active window has the color title bar, (not the gray one). 

Close Button ( [image: image6.jpg]


 ) Located in the upper right corner of a window on your screen, this icon provides one way to close an application. 

Control Menu Box  – Provides options to restore, move, size, minimize, maximize, or close an application. 

Desktop – Consists of the entire screen. There is only one desktop. 

Maximize button ( [image: image7.jpg]


 )  Located in the upper right corner of a window on your screen, this icon maximizes the window to full-screen size. 

Menu Bar  -- Provides commands applicable for use in the application.  A sample menu bar appears below.
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Minimize button ( [image: image9.jpg]


 ) – Also located in the upper right corner of a window on your screen, this icon reduces the application to an icon on the Task Bar (the portion of the screen which contains the Start button, and an area that displays buttons for each program you have open and the time).

Restore button ( [image: image10.jpg]


 ) – Restores the window to the size it was prior to using the Maximize button. 

Scrolling
· The Vertical scroll bar is located on the right side of the screen and is used to scroll up and down the page. 

· The Horizontal scroll bar is located at the bottom of the screen. This allows you to scroll to the right and left of the screen. 

· The Scroll box is another way to scroll either vertically or horizontally.  Click on the scroll box and drag the box up or down, or left or right, to change your position within the window.
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Task Bar
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The Task Bar contains the Start button, an area that displays buttons for each program you have open and the time. You can relocate the Task Bar by left clicking on it and dragging it to either the top of the screen or to either the far left or right side of the screen.

Tile – An option that allows you to arrange your active windows either vertically or horizontally, or cascade them by right-clicking on the Task bar and selecting the appropriate option. 

Title Bar – Displays the name of the application and the filename. You can maximize/restore the active window by double-clicking the Title Bar. 
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Wallpaper/Background – Refers to the image that covers the desktop or appears in the center of the desktop. 

Window – Refers to one of the large rectangular boxes on the screen in which you can run various applications, etc.  You can have several windows open at the same time on your desktop.

Identifying Some Desktop Features

Start Button    [image: image14.jpg]



You can use the Start Button to start a program, open a document, change system settings, get Help, and find files, folders, or another networked computer.

When you click on the Start button, the following menu appears:
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The Start Menu consists of the following commands:

This Command
Does this….

Programs
Displays a list of programs that you can select to start. You can also customize this list.

Documents
Displays a list of recently opened documents

Settings
Displays a list of settings that can be changed such as Control Panel, Taskbar and Start Menu

Find
Allows you to search for a file, folder, or computer

Help
Opens the Windows 98 Help Topics window

Run
Allows you run a program by entering the appropriate command

Shut Down
Displays a list of options that allow you to shut down, restart the computer, or log off and log in as a different user

Using the Trackpoint and Buttons

The trackpoint consists of  the stick on the keyboard and the three click buttons located below the keyboard.

[image: image16.jpg]



The amount of pressure you apply to the non-slip cap on the stick controls the movement and speed of the cursor on the screen.  As you press the stick away from you, the cursor moves toward the top of the screen; similarly, moving the stick toward you moves the cursor toward the bottom of the screen.  To move the cursor to the right, press the stick toward the right and vice versa.  (Please note that the trackpoint sometimes "drifts".  This isn't a defect.)  

The left and right click buttons function in the same way as those on a traditional desktop PC mouse.  (Of course these functions also depend on the software that you are using.)  The center button can be used to scroll, or as a magnifying glass by customizing the trackpoint settings.  Please refer to page 44 in your IBM User's Reference manual for instructions on how to customize the trackpoint buttons.

Identifying the Desktop Icons
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Double-click on this icon to display your computer’s contents, including the available drives and printers, the control panel, and dial-up networking.
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When you initially double-click on this icon, the only entry you will see is "Entire Network."  When you select that option, you will receive an "Unable to Browse the Network" error message, and this occurs because file and print sharing are not enabled on your laptop by default. 

If you wish to enable file and print sharing on your laptop, open the Start menu, select the Settings option, and then select the Control Panel option.  In the window that appears, double-click the Network icon, and then click on the File and Print Sharing… button.  In the window that appears, click in either (or both) of the file and print sharing options, and click the OK button.  Please note that your enabling this feature does not actually share any resources on your laptop; use the Sharing tab on the Properties window to specify the drive or directory you want to share.
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Use the Recycle Bin is a temporary "storage" place for deleted files. As long as you haven't emptied your Recycle Bin, you can use it to retrieve files that you accidentally deleted.  To completely delete any files you have placed in the Recycle Bin, first right-click on the Recycle Bin icon.  From the pop-up sub-menu that appears, select the Empty Recycle Bin option.
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Double-click on this icon to access Microsoft's Visual C++ compiler.
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Double-click on this icon to access the documentation that Academic Computing Services has assembled for laptop users.

[image: image22.jpg]Ll

License
Tnladion:




Double-click on this icon for more information about your laptop's specific licensing information.
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Double-click on this icon to access Release 5.1 of the Maple V symbolic math package.
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Double-click on this icon to access file and print sharing on the RCS UNIX platform.  You must double-click on this icon and login using your RCS userID and password to be able to print from a public machine.
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Double-click on this icon to access a separate IBM ThinkPad 600 ReadMe window that contains links to using IBM SelectaDock and/or IBM Enhanced Port Replicator, Intellisync 97 for Windows, Mediamatics DVD Express, Norton AntiVirus software, and Ring Central, which mimics a speakerphone.
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Double-click on this icon to register your specific laptop information with IBM.
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Double-click on this icon to access Microsoft's Excel spreadsheet program.
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Double-click on this icon to access Microsoft's Outlook electronic mail program.
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Double-click on this icon to access Microsoft's PowerPoint presentation software program.
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Double-click on this icon to access Microsoft's Word word-processing program.

Customizing Your Desktop 

You can customize your desktop in several ways.  To do this, right-click anywhere on the desktop; from the pop-up sub-menu that appears, select the Active Desktop option, then Customize my Desktop.

Click on the Background tab; you can now specify what image you want to display on your desktop.

You can choose to display the image in the center of your screen or the entire screen. Click on the Apply button to see a ‘preview’ of your selected image. If satisfied with your choice, click on OK.

If you click on the Screen Saver tab, you can select a preexisting screen saver or marquee (which allows you to enter your own screen saver message).  You can also choose the amount of time you want to wait before the screen saver is activated when the desktop has been idle.

Clicking on the Appearance tab allows you to customize the color scheme of the desktop, icons, active and inactive title bars, menus, windows, etc.

Moving and Resizing Windows

To move a window, left-click on the application's title bar, as shown below, hold down the left mouse button, and drag the window to a different place on the desktop. 
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To resize a window, place your mouse button over one of the four corner edges of the window until your cursor turns into a double-ended arrow ( [image: image32.jpg]


 ) as shown in the upper left corner of the title bar below.  Once you have the double-ended arrow, click and hold down the left mouse button and drag the window to the desired size. 
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Moving a Window in Front of Other Windows

To move one window in front of another, left-click on any portion of the window that you wish to bring to the front.  (You may need to move the windows around a bit in order to see the window you wish to bring forward.)

Using Scroll Bars to View the Entire Contents of a Window

You can click on the small arrows at the top and bottom of the vertical scroll bar, located on the right side of the screen, to scroll up and down the page. 

If your window has a horizontal scroll bar located at the bottom of the screen, you can click on the small arrows on either side of the scroll bar to scroll and see what text may run off the left and/or right side of the screen. 

You may also use the scroll bubble located inside the scroll bar to scroll either vertically or horizontally.  To do this, click on the scroll bubble and drag it up or down in the vertical scrollbar, or left or right in the horizontal scrollbar, to change your position within the window.

Working with Keyboard Shortcuts
Using shortcuts can save a lot of time and mouse/trackpoint maneuvering. A list of some helpful keystroke shortcuts appears below.  (For each of the shortcuts below, hold down either the Ctrl or Fn key while pressing the other key shown.)

PRIVATE
Action
Keystrokes

Copy
Ctrl + c

Cut
Ctrl + x

Paste
Ctrl + v

Standby Mode
Fn + F3

Suspend Mode
Fn + F4

Hibernation Mode
Fn + F12

Adjusting the Sound

There are two ways to adjust the sound:

· Click on the small yellow “horn” icon located in the bottom right corner of the taskbar.

· Simultaneously press the Fn + PgDn keys.  As you repeat this process, notice that the bell that sounds on your laptop gets fainter and fainter.  To increase the volume, use the Fn + PgUp keys.

To turn the sound off entirely, simultaneously press the Fn + BackSpace keys.

Powering off the Laptop

First, exit out of all programs you have running.  Next, open the Start menu and select the Shut Down… option.  The system will prompt you if you are sure you wish to shut down the computer.  If so, click Yes.  Otherwise, click No, or Help for additional information.

Installing Software

When you purchase new software for your laptop, it may help to know that some applications will automatically start the installation setup once you insert the software CD in the CD drive.  Other packages, however, may require you to load the software from floppy disks.  (Also, when purchasing software, make sure that the package is labeled for Windows PCs, and not for Macintosh computers.)

To install software, open the Start menu and select the Run option.  Type the letter of your CD drive in the window that appears, and click on Browse.  Look for the setup.exe file in the list of files that should appear.

Uninstalling Software

To uninstall a piece of software from your laptop, first open the Start menu and select the Settings option.   From the pop-up sub-menu that appears, select the Control Panel option.  In the Control Panel window that appears, double-click on the Add/Remove Programs icon.  An Add/Remove Programs Properties window will appear.  If the software you wish to remove appears in the list at the bottom of the window, click on the software you wish to delete to select it, then left-click on the Add/Remove button.  Follow the prompts that appear on the screen to finish uninstalling the software.

If the software you wish to uninstall does not appear in the list at the bottom of the Add/Remove Programs Properties window, open the Start menu and select the Programs option.  From the pop-up sub-menu that appears, select the name of the software you wish to remove, and see if there's an uninstall option available for that package.  If so, click on the uninstall option and follow the prompts to finish uninstalling the software.

Caring for Your Laptop

While your laptop is designed and tested to hold up to a lot of use, common sense should tell you that you should not misuse your machine.  Here are some tips for handling your laptop:

DON'T:

· Pick up or hold your laptop by the screen.

· Disassemble or attempt to repair your laptop yourself.

· Leave the laptop's base resting directly on your body (your legs or torso) for an extended period of time.

· Use your laptop in or near water.

· Use or store your laptop at temperatures above 95( F or below 41( F.

· Place your laptop closer than five inches from any electrical appliance that generates a strong magnetic field, such as a television, refrigerator, etc.

· Turn the laptop over while the adapter is plugged in.  (You could break the plug.) 

· Carry your laptop in a tightly packed bag.

· Touch the lens on the CD-ROM tray or the surface of the compact disk.

· Insert a floppy disk at an angle.

· Hard mount your laptop where it is subject to vibration.

DO:

· Replace the plastic bezel when you exchange drives.

· Disconnect the AC adapter when installing the CD-ROM/diskette drive.

· Apply pressure only where indicated when installing the hard disk, diskette, or CD ROM.

· Use a soft cloth moistened with non-alkaline detergent to clean your computer.

· Choose a carrying case that provides good protection for your laptop.

· Register your laptop with IBM in case it is lost or stolen, and also to receive upgrade notices.

Physically Securing the Machine

If you'd like to add a little more security to your laptop, one of the easiest ways of doing so is by using a security cable and lock.  The Campus Computer Store, located on the main floor of the Voorhees Computing Center, sells locks for $29.00.

Users who take their laptops with them while travelling may want to seriously consider using some of the following tips and tricks to make their machines more secure:

· Never let your laptop out of your sight.  Thieves are always watching and waiting for an opportunity.  So keep your machine with you at all times, even when talking on the phone, reading, etc.  And when going through airport X-ray checkpoints, hand your laptop carrying case to a member of the airport security, rather than putting it down on the X-ray conveyor belt.

· Protect your data by requiring the use of a password.

· Check to see if your insurance company offers a policy that will offer monetary compensation if your notebook is stolen.  (Rensselaer's laptop lease program includes theft and damage insurance.)

· Users may also contact the Campus Public Safety office at ext. 2401 and inquire about borrowing the department's engraving tools in order to mark their laptop and make it easier to identify if it is stolen.  Those students purchasing their laptops will also receive an identifying security decal that they can put on their machines.

Getting Warranty Information

All laptops obtained from Rensselaer have a three-year warranty, and are eligible for on-campus service and repair.  The appropriate warranty information should also have been included in the box along with your laptop.

Taking Your Laptop in for Repairs

Tempting as it may be, don't ever attempt to repair any hardware portion of your laptop yourself.  Instead, take it to Rensselaer Computer Repair, located in the lower level of the Voorhees Computing Center, and let their staff look over your machine and repair it for you.  RCR also has a number of loaner laptops available for use in case they can't repair your machine quickly.

Charging the Battery and Increasing Battery Life

Your laptop is equipped with a Lithium Ion (Li-Ion) battery, and, while it has been programmed to save battery power whenever and however possible, chances are good that you'll have to recharge the battery from time to time.  Fortunately, plugging your laptop into a standard electrical outlet should restore your laptop's battery back to full capacity in a short time.  You can also use the following "power management" techniques to help extend the life of your battery:

· Suspend mode

· Hibernation mode

Suspend mode (Fn+F4) - Although your laptop appears to be powered down when it's in suspend mode, the machine's memory contents are actually kept active at very low power.  You can bring your machine out of suspend mode by pressing any key.  Your laptop can remain in suspend mode for about three days before the battery is drained.

Hibernation mode - This mode uses no power until you restart your laptop; the machine stores its active memory to the hard disk and then turns off the ThinkPad. Entering a single keystroke should bring back up, without the need to reboot.  Your laptop can remain in hibernation mode indefinitely.

Protecting Your Laptop against Computer Viruses

Computer viruses pose a constant threat to the security and safety of the data stored on your PC, so you need to use anti-virus software, and keep it up-to-date to provide the best possible protection for which it has been designed.  Every month, the virus protection software vendors publish updates to the virus signature databases that the software uses to detect or clean a new virus, should it find its way to your system.

One virus protection product that is currently in wide use on campus is the Norton AntiVirus package, which has also been installed on your laptop.  To update this anti-virus software:

1. Make sure you're connected to the network.

2. Open the Start menu and select the Programs option.  From the pop-up sub-menu that appears, select the Norton AntiVirus option.

3. Select the Norton AntiVirus option and then click the Live Update button.

4. A Virus Definitions Update window appears.  Left-click on the drop-down arrow beside the text box and change the setting from 'Find device automatically' to 'Internet'  

5. Click OK to begin downloading the anti-virus software files.  A Transfer Completed window will appear when the files have finished loading.

6. Click the Finish button to restart your computer.

Remember, it is your responsibility to keep your PC virus-free.  We strongly recommend that you use some anti-virus software and keep it up-to--date for your own security and peace of mind.

Updating Software

Use the following URLs to access software update patches:

Microsoft Office


http://officeupdate.microsoft.com

Maple



http://maplesoft.com/patches.html

Visual Studio


http://msdn.microsoft.com/vstudio/downloads/updates.asp

Backing Up Your Critical Files

The VCC Help Desk has a number of 250MB ZIP drives that you can use to back up your critical files.  You may also purchase ZIP disks and drives at the Campus Computer Store, located on the main floor of the Voorhees Computing Center.

  A Brief Software Tour

The following sections provide a brief introduction to these commonly-used applications:

· Maple

· Microsoft Word

· Microsoft PowerPoint

· Microsoft Excel

· SecureCRT

· Web browsers

If you try the exercises in each section, you will get a feel for how each application works.  As you become more familiar with the application, use on-line Help to learn more. 

On most machines, you will find an icon on the desktop for each of the applications.  If it isn't there, click the Start button at the bottom left of the screen, then click on Programs and select the program you wish to use.

Starting Programs

To start a program, click on the Start button and scroll up to Programs. A list of the available programs will display.  Scroll to the folder to see what programs are available.  Once you locate the application you want to start, click on it. 

Note: When you see a small arrow next to a folder name, this indicates that if you click on this folder, another menu will appear, displaying more options. Also, you don’t need to keep the mouse button depressed to navigate through the menu. 

Switching between Programs 

Once you start a program, a button that represents the program appears on the Task Bar. To switch from one program to another, simply click on the appropriate program button on the Task Bar.
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For example, the Task Bar above shows that MS Word and Corel PhotoPaint are both running. To switch between the two programs, left-click on the button to which you want to switch. 

Closing Programs 

There are several ways to close a program: 

· You can click on the "X" icon located in the top right-hand corner of the window.

· You can single click on the program's File menu, then select the Exit or Close option.

· You can double-click on the upper left-hand corner program icon. (For example, for MS Word it would be the "W" logo.) 

Note: If you haven’t saved your work before closing the program, the system will prompt you to do so.

Maple

If you'll be taking Calculus in the fall, it's very likely that a good portion of your coursework will use Maple, a program that performs symbolic, numeric, and graphical mathematical computations.  The package's many capabilities include the ability to:

· Calculate

· Manipulate variables

· Solve equations analytically and numerically

· Differentiate and integrate

· Compute limits

· Create two- and three-dimensional graphs

Starting Maple

Double-click on the Maple icon on the desktop. Or, if the icon is not visible, open the Start menu, select the Programs option, select Maple V Release 5, then select Maple V Release 5.

When the program starts, an "Untitled" Maple worksheet will appear as a sub-window inside the main Maple window. 

Trying Some Maple Commands

Once the window appears, work through the following exercises, entering the commands at the Maple prompt (>).  Also remember that all Maple statements must end with a semicolon (;). 

Maple can add (+), subtract (-), multiply (*), divide (/), and exponentiate (^) like a calculator.

1 + 1;
Maple can manipulate symbols as well as numbers.

x + x;
You can assign expressions to variables using the assignment (:=) operator.

y:= x*sin(x);
Maple can plot functions; y is plotted on the vertical axis and x is plotted on the horizontal axis. In the example below, the values of x range from 0 to 10.

plot(y, x=0..10);
The caret (^) denotes exponentiation in the assignment statement below.

 z:= x^2 - 2*x;
You can plot two functions on the same axes. Pi (not PI or pi) is Maple's name for (.

plot({y,z}, x=0..2*Pi);
Maple can also find where y and z intersect. Does this solution agree with the plot?

fsolve(y=z, x, x=2..3);

Finding Documentation and Getting Additional Help

Memo RPI.108, Using Maple on RCS, provides more information about using Maple. The memo also includes a self-paced tutorial that you should work through before your first class in the fall. 

Maple also has an extensive on-line help facility.  To access it, either click on the Help button at the top of the Maple window, or enter a question mark (?) at the Maple prompt.

Quitting the Program 

To exit Maple, pull down the File menu and select the Exit option. The program will prompt you if you wish to save your work. (Select the No option at this time.)  As you become more familiar with Maple, you'll find that you can use other options on the File menu to save and print your Maple worksheet.

Microsoft Word

Starting Word

To start Word, double-click on the Microsoft Word icon on the desktop. A new blank document, as shown below, will open, ready for you to enter text. Most of the tools and commands you need are on the menus; however, the Standard and Formatting toolbars, displayed just below the menu bar, provide quick access to commonly used commands. 


Getting Help

If you need help, click on the Help menu, select "Microsoft Word Help," type your question in the Office Assistant, and then click Search (or press Enter).

Entering Text

The blinking vertical line in the work area of the document, called the insertion point or cursor, is the location in the document where text will be inserted and where certain editing options will take place.  To enter text, simply begin typing.  You won't have to press Enter at the end of the line, since Word will automatically wrap the text to the next line when you reach the right margin.

As you type, don't worry if you make a mistake.  You can correct mistakes by either pressing the Backspace key to erase the characters to the left of the cursor, or by pressing the Delete key to erase the characters to the right of the cursor. The Edit menu provides commands to cut, copy, and paste text. 

Before you start typing, you may want to go to the View menu and select Normal. This gives the best all-purpose view for typing, editing, and viewing the text, although page boundaries, headers and footers, and some graphics do not appear.  To see the complete page layout, use Print Layout view.

Creating a Document

When using Word, it's easiest if you remember the rule: "Select, Then Do." That is, first select the text and then do the command; e.g., bold, copy, delete, etc.

1. Type some text appropriate for a title, such as "A Test Document" and press Enter.

2. Select the text you just typed (by dragging the mouse over it), then:

a) Click on the centered-lines icon ( [image: image35.jpg]


 ) on the toolbar to center it.

b) Click on the font name down-arrow ( [image: image36.jpg]Times New Roman =



 ) and select Arial.

c) Click on the down-arrow next to the font size (10) ( [image: image37.jpg]


 ) and select 22 to make it large.

d) Click on the B ( [image: image38.jpg]


 ) on the Formatting toolbar to make it bold.

3. Click outside the title to deselect it. The cursor should now be positioned at the beginning of the next line.

4. Click the font size down-arrow and select font size 12 to change the text of your document to a larger font size.  

5. Type a few sentences. Press Enter to start a new paragraph; press Enter twice to get a blank line between paragraphs. 

6. Open the File menu and select the Page Setup… option.  In the window that appears, change the left and right margins to 1.5.

7. If you don't like the result, press the "undo" icon ( [image: image39.jpg]


 ) on the Formatting toolbar. 

8. To make a bulleted list, click on the bulleted list icon ( [image: image40.jpg]


 ) on the Formatting toolbar. Now, each time you press return, you will get a new bullet. Click the icon again to end the bulleted list.

Saving Your Work

While you're working on a document, it's a good idea to save your work frequently.  To do this, pull down the File menu and select the Save option.  

If you're saving a file for the first time, a window will appear on the screen, and you need to:

· Specify where to save the file.  (Word will save the file in the current folder by default, but you can select another disk or folder in the Save In: field.)

· Provide a filename in the File Name: field.

· Specify the file type.  Word will save the file as a Word (.doc) file by default, but you may also click on the drop-down arrow in the Save as type: field and select one of the other available options.

To save an existing file under another name and/or location:

Open the File menu and select the Save As… option.  Enter the new filename and/or location, respectively, in the File Name: and Save In: fields in the window that appears, and click the Save button.  Doing this will save the edited file under the new filename, and will leave the other file as it was, under its original filename.

Quitting Word

Quit Word by going to the File menu and selecting Exit. (Alternatively, you may click on the Close (X) icon on the title bar or press Alt-F4.) If you haven't already saved the document, you will be asked if you want to save your changes. Select the No option at this time. If you say Yes, the program will prompt you to enter a filename. (Word will supply the standard filename extension ".doc" by default.)  As you become more familiar with Word, you'll find that you can use other options on the File menu to save and print your Word document.

Microsoft PowerPoint

Starting PowerPoint

To start PowerPoint, Microsoft's presentation software, double-click the PowerPoint icon on the desktop. As in Microsoft Word, the Standard and Formatting toolbars appear along the top of the PowerPoint screen just under the menu bar. The Drawing toolbar appears along the bottom of the screen. The toolbar buttons are shortcuts that duplicate menu items. 

Creating a New Presentation

In the dialog box that appears after you start the program, select Design Template and click OK. PowerPoint provides a variety of templates using different designs and colors. If you click on different designs, you'll see a preview on the right side of the dialog box.
The steps below describe how to create a simple presentation using the Azure template.
1. Select the Azure template and click OK.
2. In the New Slide dialog box that appears, click on the Title Slide AutoLayout and click OK.  Your screen should look like the picture below.



Just above the Drawing toolbar, on the bottom left, are five View buttons. As you work, you can select any of the Views and switch between them by clicking on the appropriate icon. 

· Normal View appears when you first start using PowerPoint. This Tri-Pane view makes Outline view, Slide view, and Notes view available simultaneously. You can adjust the size of each pane by dragging the pane borders.

· Outline View allows you to work on more than one slide at a time and is an efficient way to organize your presentation; however, you may only insert text. 

· Slide View shows how the actual slide looks. You can insert objects in addition to text. 

· Slide Sorter View allows you to see all your slides and rearrange them if you wish. 

· Slide Show view displays your slides in full-screen size, one at a time. Use this view to give your presentation.

You may prefer to work in Slide view.  To try it, click on the third  View button (which looks like an empty square) or select Slide View from the View menu.

3. Click in the top text box and type a title; click in the bottom text box and type a subtitle.

4. From the Insert menu, select New Slide. 

5. Select the Bulleted List AutoLayout and click OK.

6. Type in a title for the new slide, then type in several items for the list.

7. Insert several more Bulleted List slides and add some text to them. 

a) Working in Slide View:  Prepare one slide at a time, inserting or changing text using the buttons on the Formatting toolbar (bold, italic, bullets, font changes, etc.). Note the promote and demote arrows near the right end, which change the level of the current heading. And don’t forget the undo button (arrow curving to left) on the Standard toolbar. Add new slides by using the New Slide button or the Insert menu. Move from slide to slide using the up and down double arrows at the bottom of the scroll bar.

b) Working in Outline View:  You can type the text of several slides at once. Control the levels of the headings (including whether it’s a new slide) by using the promote and demote arrows on the toolbar.

Inserting Clip Art  

First, using Slide View, insert a new bulleted-list slide, and type in the title and one or two items for a list. To insert a picture, follow the steps below.

1. From the Insert menu, select Picture and then Clip Art. In the Clip Art Gallery that appears, click on the icon for the desired category.

2. Click on the object you want, then click the Insert Clip icon; PowerPoint will insert the picture in the current slide, "selected" with small white squares. Close the Clip Art window.

3. To resize the object, move the left mouse button over a corner until a diagonal double-ended arrow appears, then drag the mouse to achieve the desired size. To move the object, left-click on it to select it (a four-headed arrow will appear), hold down the left mouse button inside the object, and drag it to the desired location. Click outside the image to deselect it.

Viewing Your Presentation 

1. Select the first slide by using the scroll bar or arrows along the right side of the screen. 
2. From the View menu, select Slide Show (or click on the Slide Show button along the bottom left of the screen). 
3. Click to move to the next slide. 
4. Leave the Slide Show at any time by pressing the Esc key.
Quitting PowerPoint

Quit PowerPoint by going to the File menu and selecting Exit. (Alternatively, you may click on the Close (X) icon on the title bar or press Alt-F4.) If you haven't already saved the document, you will be asked if you want to save your changes. Select the No option at this time. If you say Yes, the system will prompt you to give your document a name.  PowerPoint will supply the standard filename extension ".ppt" by default.

Microsoft Excel

Starting Excel

To open the Excel spreadsheet program, double-click on the Excel icon on the desktop. A blank worksheet will open, ready for you to enter information. Underneath the menu bar at the top of the page, you will notice the Toolbar for use while opening, editing, and saving a worksheet and the Formula Bar for editing cell entries.  
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The Excel worksheet contains columns and rows. The place where a column and row intersect is called a cell.  Each cell has an address that consists of the column letter and the row number (for example: A1, B4, C6).

Notes on Entering Data 

To enter data or a formula into a cell, first select the cell and then start typing.  Press Tab or Enter to register what you have typed. When you type in a cell, the cell’s address appears in the left corner of the Formula Bar, and what you type appears in the Formula Bar text box. Note that to change the entry you edit the text in the Formula Bar, not in the cell itself.

You can enter many types of data in an Excel worksheet, such as text, numbers, dates, times, formulas and functions. It is easiest to type your data first and format the data (using the Format menu) when it is completed. Therefore, don’t type commas, dollar signs, or percent signs while entering data. 

To enter a formula, select a cell and then start by typing an equal sign (=). Use parentheses to force the order of operation: exponentiation (^), multiplication (*), division (/), addition (+), and subtraction (-). 

Getting Help

If you need help, click on the Help menu, select "Microsoft Excel Help," type your question in the Office Assistant, and click Search.

Creating a Worksheet

To get started with Excel, make a short grocery list with prices for each item and sum the result (including tax) to see what you will owe. The steps below will guide you through one way of doing this. When you are finished, the result should look like the picture shown below.
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1. First type in the headings:  Click in cell A1 and type Quantity. Type the remaining headings by using the Tab key to move to the next cell. Select the entire first row by clicking on the row heading (the 1 at the left).  In the Toolbar, click B (for bold).

2. Leave a blank row after the headings, then click in cell A3 and type the number 1.

3. Press the Tab key to move to the next cell. (Notice that Excel recognizes that you typed a number and right-justifies it.) 

4. In cell B3, enter lb; in cell C3 enter apples and in cell D3, enter .99.

5. Do not type anything in column F; Excel will calculate this for you!

6. For the next row, click in cell A4 and enter the remaining rows of data the same way. Row 9 (notebooks) will have an empty cell for Units. In cell E9, type .08; do not type the % sign.

Formatting the Data. To put column D in a $ format, first select all of column D by clicking on the D at the top of the column. Then, from the Format menu, select Cells… and then Currency. Click OK. Do the same for column F, which will contain the totals.

To format column E as a percentage, first select column E; from the Format menu select Cells… and then Percentage. Click OK.

Entering Formulas. To make totals in Column F, we want to add column D (unit cost) to Column D times column E (figure the tax) and multiply that sum by Column A (quantity).

1. Click in cell F3. Type =a3*(d3+d3*e3) and press Enter. 

2. Click in cell F3 and drag to cell F9 to select cells F3 through F9, then go to Edit menu and select Fill and then Down.  Presto! The formula from cell F3 is applied to all selected cells.

3. For the grand total, click in cell F11, double-click the AutoSum button () on the Toolbar, and press Enter. 

4. To finish, click in cell E11 and type the text Total.

Creating a Chart

You can display Microsoft Excel data graphically in a chart. To insert a chart, select the cells that contain the relevant data. If you want the column and row labels to appear in the chart, include the cells that contain them in the selection. (If the columns are not adjacent, hold down the Ctrl key to select them both.) From the Insert menu, select Chart, and follow the instructions in the Chart Wizard.

Quitting Excel

Quit Excel by going to the File menu and selecting Exit.  (Alternatively, you may click on the Close (X) icon on the title bar or press Alt-F4.) If you haven't already saved the document, you will be asked if you want to save your changes. Select the No option at this time. If you say Yes, you will be asked to give your document a name. Excel will supply the standard filename extension ".xls" by default. 

Connecting to Other Host Computers via SecureCRT

You can use your laptop and public PCs to connect to RCS or other UNIX systems over the network.  When you do this, you should use SecureCRT to ensure that all communication with the remote host is automatically encrypted.  (This is in contrast to a conventional way of establishing a session using telnet, which transmits your userID, password, and other private information in an easily readable format.)  As a result of SecureCRT's greater security, CIS strongly recommends that all PC users use this program.

SecureCRT is installed in the public PC labs, and freshmen who receive laptop computers in the fall should already have SecureCRT automatically installed as part of their machine's image.  However, SecureCRT is available to everyone; CIS has purchased enough SecureCRT licenses for the entire Rensselaer community.  The software costs $10 per license; this fee will appear as part of the printing charges on your Bursar's bill.

Obtaining SecureCRT

Instructions for obtaining the license are on the Web; click on the Computing & Information Services (CIS) Home link under the "Computing" section of the RPInfo homepage, then select the Computer Labs & Software, Software to download, and SecureCRT links.

Getting Help

Once installed on your PC, SecureCRT is easy to use. Extensive help is available from the Help menu.

A Sample SecureCRT Session

To establish a connection to one of the RCS UNIX remote hosts, double-click on the SecureCRT icon on the desktop. A Connect window will appear:

1. Select a host from the Session List (for example, rcs-ibm.rpi.edu) and click OK.

2. The first time you connect to a given host, a dialog box will pop up saying, "The remote host has not been registered." Choose the option Accept & Save. 

3. Enter your RCS userID and password at the prompts.

4. A UNIX window will appear. You are now ready to enter UNIX commands at the prompt. (Note that this connection does not give you access to applications that require an 
X-windows display, such as FrameMaker.)

Once you've established your SecureCRT connection, try out some basic UNIX commands by typing the following commands in the UNIX window and then pressing Enter, as shown in the examples below:

· To check how much disk space you have in your UNIX account:


fs lq  

This command stands for "filesystem list quota." The amount in the Quota column shows your total disk space (in kilobytes). The percentage in the %Used column tells you how much of your allotted disk space you have used. (The Partition percentage is not relevant to your individual account.) 

· To list the names of the files and directories in your home directory:

ls

The names you will see are the subdirectories initially created for you. The directory called public_html is the place to put personal Web information. There are no files in your account unless you create them.

· To check the print queue on the double-sided printer in the VCC machine room:

lpq -Pvclw

The full name of this printer is "VCC LaserWriter."  You can check the queue for any of the networked printers by entering the printer name after the -P option.

· Every student is given $12.50 of free printing per semester. To check how much of your printing allocation you have used, enter the command:

pagestatus
· Be sure to exit your UNIX session by entering the command:

logout 

Quitting SecureCRT

Quit SecureCRT by going to the File menu and selecting Exit. (Alternatively, you may click on the Close (X) button on the title bar or press Alt-F4.)

Web Browsers:  Netscape and Internet Explorer

Web browsers allow you to find and view information on the World Wide Web. The public computer labs and the Rensselaer laptops have the two most commonly-used browsers:  Netscape and Internet Explorer.

Starting the Browser

To start either browser, double-click on the appropriate icon on the desktop: 

· To start Internet Explorer, double-click on the Internet Explorer icon 

· To start Netscape, double-click on the Netscape Communicator icon

If neither icon appears on your desktop, go to the Start menu, then to Programs, and select the appropriate option for the desired browser. 

The window displays a default home page, the page you see each time you start the browser. On Rensselaer computers, both browsers are pre-set to display RPInfo, the on-campus home page. 

Near the top of the browser window, there's a box that contains the address of the page being viewed. In Netscape, the name of the box is Location; in Internet Explorer it's called Address. This address is called a URL (Universal Resource Locator). Each page on the web has its own unique URL that identifies its location. 

Much of the time, especially when you're browsing within RPInfo, you won't need to know a page's URL because you will go to a page by clicking on "active" text called a link. However, if you can't get to the page by clicking a link, you will have to type the specific URL of a page.

Viewing Other Web Pages

Try the following steps by using links to navigate between web pages. Note that to retrace your steps, you click the Back button on the toolbar. To return to the RPInfo home page, click the Home button.

1. Under the main heading Computing, click on the link for Academic Computing Services. (You might have to scroll down using the arrow at the bottom of the right side of the window.)

2. Look for the ACS documentation link and click on it. A page will appear that contains links for Memos and Quick Studies on a variety of topics.

3. Click on the Home button to return to the RPInfo page.

Now try viewing a page by entering its URL. When typing a URL, you must enter the characters exactly as specified. For example, the home pages of individuals at Rensselaer begin with the tilde character (~), which designates a particular home directory on a server.

1. Click in the Location or Address field, type the following URL, and then press the Enter key:
 
http://www.unitedmedia.com/comics/dilbert/archive/
2. Read the latest cartoon.

3. Scroll down until you see a calendar and click on a date.

4. Read the cartoon for that date, then click the Back button to return to the main Dilbert page. If you want, look at cartoons for some other dates.

5. If you would like to return to the Dilbert page another time without typing the URL, you can add the page to your Bookmarks (Netscape) or Favorites (Internet Explorer):

a) In Netscape, click on the Bookmarks button from the Location Toolbar, then click on Add Bookmark.

b) In Internet Explorer, click on the Favorites menu, then click on Add to Favorites….  
A dialog box will appear, giving you the opportunity to select a folder. Click on 
Create In<<.

6. When you are tired of Dilbert, click the Home button to return to RPInfo.

Getting Help

Both Netscape and Internet Explorer have extensive help available from the Help menu.

Additional Tools

Both browsers also include tools for electronic mail and participating in newsgroups. 

· In Netscape, you access these tools from the Communicator menu or by clicking the Tools buttons at the bottom right of the window.

· In Internet Explorer, use the Tools menu.

Quitting the Browser

Quit the browser by going to the File menu;

· Select the Exit option in Netscape

· Select the Close option in Internet Explorer. 

(Alternatively, you may click on the Close (X) button in the upper right corner or press Alt-F4.)

Finishing Up and Logging Out

Wherever you're working on campus, it's a good idea to save all of your work and quit out of all applications.  If you're working at a PC, you should also consider copying any files that you want to save to either a floppy disk or over to your RCS UNIX file space.

To log out from a Windows 95/98 machine: Double-click the Logoff icon, which looks like a door with an arrow, located in the bottom right corner of the desktop. Double-clicking this icon will remove any files you created from the machine, as well as remove any access to files in your RCS UNIX file space, if you accessed them.

To log out from a Windows NT machine: Open the Start menu in the lower left corner of the desktop, and select the Shutdown and Close all programs and log on as a different user options.

Please, keep your account secure…always remember to log off!

  Getting Help and Additional Information

You can find plenty of help and useful information from the sources listed below.

Help Desk Locations
Both the Rensselaer Libraries and Academic Computing Services offer Help Desk locations.  

· During the school year, ACS has one Help Desk location on the main floor of the Voorhees Computing Center and another in CII 3111.  (The CII Help Desk is closed during the summer.)  You can contact the student consultants and full-time staff who work at ACS' two Help Desk locations by either stopping in, phoning ext. 7777, or by directing e-mail to consult@rpi.edu.

Regular Help Desk hours appear below.


Monday - Thursday

8:30am - 10:00pm

Friday


8:30am - 4:00pm

Saturday


Closed

Sunday


4:00pm - 10:00pm

· In the Folsom Library, you may direct your questions to the library's Reference and Circulation Desk staff or send electronic mail to lib-support@rpi.edu.

Documentation

Academic Computing Services produces documentation on how to use many campus computing services, facilities, and applications.  ACS Quick Studies are one-page, instructional documents; ACS Memos provide much more detailed information.

Printed copies of ACS Quick Studies and Memos are available in the documentation racks outside the VCC Help Desk.  They are also available on-line; to access them via RPInfo, select the Academic Computing Services link under the "Computing" section of the RPInfo homepage, then select the ACS documentation link. Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/Computing/Docs/docs.html
RPInfo
Rensselaer has a diverse and dynamic presence on the Web.  Information from all corners of campus can be found on-line, from class schedules and academic programs to Union clubs, library information, computing-related news and documentation, and much more.  RPInfo, Rensselaer's information system, aims to bring this all together in an efficient and accessible manner.   For instance, you may reach the Student Information System and register for classes on-line by starting at RPInfo, located at the URL http://www.rpi.edu/rpinfo, or you might navigate to the Athletics section of the RPInfo homepage and choose an intramural team to join.  You can also navigate to the Academic Computing Services homepage for computing-related help.  No matter what your interest, RPInfo will lead you to many valuable on-line resources. 

Please refer to the "Using RPInfo" section of this document for more specific information in starting and using this useful information resource.
Short Courses

From time to time during the school year, and sometimes during the summer, both Academic Computing Services and the Libraries offer non-credit short courses; ACS provides instruction on how to use various computing utilities and applications, and the Libraries offer short courses on how to access and use the many databases and other resources that they have available. 

Upcoming courses are often announced in The Poly, The Review, and The Kiosk publications, and are also posted on-line via the ACS and Libraries' RensSearch homepages.

The Kiosk

The Kiosk, CIS' departmental newsletter, is published at regular intervals during the school year to keep the Rensselaer community informed of news and information from all CIS departments.  

The Kiosk is available by subscription free-of-charge.  To subscribe and have the newsletter sent to your on- or off-campus address, please send your name, address, and Rensselaer affiliation via electronic mail to kiosk-subscribe@rpi.edu.  You may also pick up hardcopies of the newsletter from the VCC Help Desk and in the Folsom Library.

Current and back issues of The Kiosk are available on-line.  To access them, select the Academic Computing Services link from the "Computing" section of the RPInfo homepage, then select the The Kiosk link.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:


http://www.rpi.edu/Computing /Kiosk/Kiosk.html

rpi.computing.news Usenet newsgroup

Academic Computing Services recommends that you regularly read the rpi.computing.news Usenet newsgroup to stay up-to-date on all the latest important computing-related information, such as new releases of software, system bulletins (power and server outages, etc.), announcements of short courses, and more. 

To learn more about how to read Usenet newsgroups, please see Memo RPI:116, Usenet News, and Quick Study #7, Reading News Groups Using Netscape Communicator.


  An Introduction to the Rensselaer Computing System

About Your RCS Account

The Rensselaer Computing System, or RCS, consists of hundreds of networked personal computers, UNIX workstations, and laptop jacks. As a member of the Rensselaer community, you are given an RCS account (known by your RCS userID), which provides access to the campus network, printing facilities, the World Wide Web, and electronic mail, as well as disk space.  Using your RCS userID and password, you can sit at any campus workstation or personal computer , or use your laptop, and use public software, access your own or other publicly-available files, or connect to any of several host computers on the network.

Your RCS userID, which is public information, is derived from the first five characters of your last name followed by your first initial and, in some cases, a number to ensure its uniqueness. Your password, however, is private, and it is very important to maintain that privacy in order to safeguard the information and resources in your account. Because the password originally given to you has been seen by a number of people and is also hard to remember, you should change it as soon as you have an opportunity.

Choosing and Changing Your RCS Account Password

It might seem like a very simple thing, but choosing a good RCS password actually takes some careful thought, and it might take you a while to think of an appropriate one.  Your password is the key that unlocks your RCS userID and provides access to your files, so you'll need to think of a good password.

So what can be so tough about that?  Well, you need to pick a password that you can remember without writing it down, but which others cannot easily guess. That is, don't use a password that might be fairly obvious, especially to anyone who knows you, such as the names of people, cars, months, or rock groups, or any real words that you can find in a dictionary. 

Your password must contain exactly eight (8) characters, including at least one digit or punctuation mark.  Using these techniques should greatly reduce the chance of anyone guessing your password.

When you think you have chosen a good password, use a web browser to access the password changing program, which you can access via the CIS homepage.  (To do this, select the Computing & Information Services (CIS) Home  link to get to the CIS homepage, then click on the Accounts, RCS Accounts (Computer), and Changing Your RCS Account Password links.)  The system will prompt you to verify your identity by entering your RCS userID and current password.  Then follow the instructions on the screen to change your password.  (The system also allows you to test your potential password before you actually set it.)

If you would like additional help in choosing your RCS password, or if you forget your password and need a new one, please contact the ACS Help Desk.

Using Your Account Responsibly:  Some Words of Wisdom

We'd like to take a minute to discuss something that we take very seriously here at Rensselaer, and that is the issue of computing ethics.  All students, faculty, and staff members are given a computing account -- known as your RCS userID -- that allows access to the Rensselaer Computing System (RCS) and its many resources.  However, ethical principles that apply to everyday academic life also apply to the use of the campus' computing resources -- having many computing privileges means you also have many responsibilities.   When you received your computing account userID and password, you were asked to read and sign an agreement to abide by Rensselaer's Conditions of Use statement, and to use your account in an appropriate and responsible manner.  

You can find Rensselaer's official policy on electronic citizenship on-line; to access it, select the Computing Etiquette link from the "Computing" section of the "internal" RPInfo homepage, then select the Committee on Electronic Citizenship link.  Alternatively, you can specify the following URL in the Address or Location field at the top of your browser window.   


http://www.rpi.edu/web/comec/
The Rensselaer Handbook of Student Rights and Responsibilities also outlines your responsibilities to read and understand these guidelines.  We've listed some of the appropriate and prohibited uses of your computing account here for you.

Appropriate Account Uses

· Coursework and Research.  The primary reason that Rensselaer funds computing is to support an academic program that gives you technological training to enable you to function effectively in the working world, and you will find that many of your courses here at Rensselaer will use some form of computing in their curricula.  You can also make use of the campus' computing resources for research, such as using Pro/ENGINEER for special design projects, or using Rensselaer's Numerically Intensive Computing (NIC) facility.

· Writing a Paper, Thesis, or Résumé.  The Rensselaer Computing System offers a number of document-preparation applications on its various platforms, including Microsoft Word, Adobe FrameMaker, and LaTeX.

· Electronic Mail.  E-mail provides a fast and convenient way to stay in touch with your professors and fellow students here on campus, as well as with your friends and family around the world.

· Searching the World Wide Web.  "The Web" provides you with a connection to the vast amount of information that resides both inside and outside Rensselaer, so feel free to "surf" around on-line to take advantage of this important resource.  You will also find that many Rensselaer students and faculty members have created their own homepages on the Web.

Prohibited Account Uses
· Sharing your password with others.  We cannot stress strongly enough how important it is to keep your password private; anyone who has access to your password can, either unintentionally or with malice, read, delete, or change your files, as well as read your e-mail or send e-mail using your name. What's more, anyone who knows your password can use it to see your grades, access your personal information listed via the Student Information System, and use your printing allocation.  Therefore, to avoid the chance of these things happening, change your password frequently, and use proper means to share your files.

· Sending, replying to, or forwarding chain mail.  When you send chain mail, you ask all of the recipients of your message to forward that message to as many people as they know, and each of those people will in turn send the message to everyone they know, and so on. Simple arithmetic will show you the burden this can place on a mail machine.  Basically, chain mail does little more than take up space on the system and waste your time!  So, if you ever consider starting up a chain mail letter, please…think twice.  And if you ever receive one, "just say no," and forward it to postmaster@rpi.edu. Similarly, if you receive e-mail about a virus and are asked to forward it to everyone you know, please don't!  Again, send a copy of the message to postmaster@rpi.edu.  If a real virus threat does exist on campus, the appropriate staff will notify the campus.

· Sending anonymous, harassing, obscene, or forged mail.  This behavior can range from "merely" inappropriate to downright illegal.  Hey, think about it…you don't want to receive this kind of mail either via the US Postal Service or via computer, so why should anyone else?  Sending this kind of mail could result in the loss of your RCS privileges, or even disciplinary or legal action. And if you ever receive electronic mail that is in any way threatening or harassing, or which you feel might be a forgery, forward the message to postmaster@rpi.edu as soon as possible. 

· Sending large amounts of mail.   As with chain mail and other types of inappropriate mail, sending "mail bombs" irritates people and ties up the system, degrading mail service.  Sending such mail could also possibly result in disciplinary and/or legal action.

· For commercial purposes.  Rensselaer's licensing agreements prohibits commercial use and using your account for such purposes could jeopardize the Institute's position as a member of the Internet community.

· Displaying offensive materials.  It's all too easy to access, view, and copy sexually explicit and other potentially offensive materials on-line, and, by right, Rensselaer cannot forbid users from obtaining these files.  However, because it is nearly impossible to avoid seeing large images displayed on other users' computer screens, Rensselaer considers the display of such material within its labs to be public display, which creates a hostile working environment in violation of Rensselaer's policy regarding sexual harassment.  In addition, the practice of publicly displaying sexually explicit or similarly offensive material is a Class A misdemeanor under New York Penal Law 245.11.  Therefore, view such material elsewhere to avoid offending others.

· Putting Copyrighted Material on Your Homepage.  Unless you receive a person's express permission to do so, using any material that appears on their webpage is considered stealing.  

To access more information on copyright issues, first select the RensSearch link from the "libraries" section of the RPInfo homepage, then select the Information, Library Policies, and Copyright Law Highlights and "Fair Use" Guidelines links from the respective pages that appear.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.lib.rpi.edu/dept/library/html/information/policies/lawhighlights.html

Using Electronic Mail

Understanding Your E-Mail Address

Your e-mail address consists of the userID you received with your computer account, such as smithj, appended with @rpi.edu; for example, smithj@rpi.edu.

It's very important to make sure that you provide the correct e-mail address before you send out e-mail to ensure that you send that message to the correct person.  When you don't know someone's e-mail address, don't just guess it!  Sending e-mail to the wrong person can cause possible embarrassment, or even disciplinary action, depending on the message's content, etc.

Using Various E-Mail Programs

You don't need to use the same e-mail program as your friends in order to send or receive mail messages.

Many users send and receive e-mail either via Internet Explorer, Netscape, or Outlook on their PCs.  Quick Study #5, Using Netscape Mail in the RCS Environment, explains how to set up your Netscape mail; printed copies of this document are also available in the documentation racks outside the VCC Help Desk.  You may also access the document on-line by selecting the Academic Computing Services link from the "Computing" section of the main RPInfo homepage, then selecting the ACS documentation link from the ACS homepage that appears. Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:


http://www.rpi.edu/Computing/Docs/docs.html

Z-Mail is the default mail package on the UNIX platform.  Some users choose to use other mail programs, such as mh or pine, but CIS does not support these packages.

Finding Others' E-Mail Addresses

For locating Rensselaer student, faculty, and staff, you can use the campus directories that are available via RPInfo; to access these, select the Campus Directories link under the "People & Places" section of the main RPInfo homepage.  You may then enter the person's first and/or last name; if the system finds a personnel match, it will often display that person's e-mail address along with their name, office location, phone number, and department.

Often, the easiest way to find an off-campus friend's e-mail address is to ask them:  face-to-face, on the phone, or via the U. S. mail.  However, you can also try using an on-line search engine to conduct an on-line search for your friend's school's homepage, and then seeing if you can access some sort of student directory from there.  However, please note that this procedure may not always work, since not all universities choose to make their students' e-mail addresses public.  In addition, it's possible that new students might not receive their e-mail addresses right away, so you might have better luck looking up someone who's been on campus at their university for a month or two.

Once you know someone's e-mail address, you can create an alias to save the address.  This not only allows you to delete the other person's message (rather than save it simply so you have a record of their e-mail address), but lets you enter a single word as the e-mail address, instead of having to enter a longer, complicated address.

Setting Options for Various E-Mail Programs

Configuring Netscape Mail

Start Netscape Messenger.  From the window that appears, open the Edit menu on the menu bar and select the Preferences… option.  A Preferences window, as shown below, will appear.  Click on Mail & Newsgroups in the Category: field, then Identity.  Complete the Your name and Email address fields as shown below, where xxxxxx is your RCS user ID. 
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Next, click on the Mail Servers option listed in the Category field.  Enter mail.rpi.edu in the Outgoing mail (SMTP) server field, as shown on the following page.
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Next, click on the Edit… button to edit the Incoming Mail Servers listed in the window above.  A separate Mail Server Properties window, shown below, will appear.  Click on the General tab, and enter mail.rpi.edu in the Server Name: field.  Make sure that the Server Type is POP3 Server.  Finally, enter your RCS userID in the User Name: field. 
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Next, click on the POP tab.  Select both options, as shown on the following page.  (The Leave messages on server option allows you to pick up your e-mail from multiple computers.) 
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Configuring Outlook Mail

Start Microsoft Outlook.  Open the Tools menu and select the Options… option.  A separate Options window, as shown below, will appear.
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Click on the Mail Delivery tab, then click on the Accounts… button, shown in the window below.
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The window shown below will appear.  Click on the Add button, then select Mail.  
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The following window will appear.  Enter your name in the Display name: field and click the Next button.
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The following window will appear.  Enter your e-mail address in the E-mail address: field and click on the Next button.
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The following window will appear.  Enter mail.rpi.edu in both the incoming and outgoing mail servers and click the Next button.
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The following window will appear.  Enter your RCS userID in the Account Name field and click the Next button.
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The following window will appear.  Select the Connect using my local area network (LAN) option and click the Next button.
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The following window will appear.  Click on the Finish button to finish configuring your Outlook mail.
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Using RPInfo

While you may already be familiar with Rensselaer's website for visitors and prospective students (located at the URL http://www.rpi.edu), now that you are on campus, you will want to use our internal information system, known as RPInfo (located at http://www.rpi.edu/rpinfo).  RPInfo acts as the campus computers' default homepage.  You can find information from all corners of campus in RPInfo, from class schedules and academic programs to Union clubs, library information, computing-related news and documentation, and much more.

Users who have questions about webpage authoring, linking, and training may direct electronic mail to rpinfo_support@rpi.edu.

Accessing RPInfo 
To access RPInfo from either Web browser, double-click on the appropriate icon on the desktop: 

· To start Internet Explorer, double-click on the Internet Explorer icon 

· To start Netscape, double-click on the Netscape Communicator icon

If neither icon appears on your desktop, go to the Start menu, then to Programs, and select the appropriate option for the desired browser. 

The window displays a default home page, the page you see each time you start the browser. On Rensselaer computers, both browsers are pre-set to display RPInfo, the on-campus home page. 

Working with Bookmarks/Favorites

Bookmarks provide you with a quick, easy way of accessing those Web sites you know you'll want to visit again and again.  The chart below outlines the steps you'll need to add to, and edit, your bookmark list using Netscape Communicator and Internet Explorer.

If you want to…
…and you're using 
Netscape Communicator…
…and you're using 
Internet Explorer…

Add a bookmark for the Current Page
Click on the Bookmark button from the Location Toolbar, then click on Add Bookmark.  Alternately, you may pull down the Communicator menu, select the Bookmarks option and then select File bookmark.  This gives you the option up front to place the bookmark in the folder of your choice.
Pull down the Favorites menu and select the Add to Favorites… option.  Click the Create In>> button; the system will prompt you to specify where you want to place the bookmark.

Edit Your List 
of Bookmarks
Pull down the Communicator menu, select the Bookmarks option and then select Edit bookmarks.  A Windows Explorer style window will appear, and you can then move a bookmark to an existing folder by clicking and dragging, or create a new folder in which to place the bookmark.
Pull down the Favorites menu and select the Organize Favorites… option. A Windows Explorer style window will appear.  You can then move a bookmark to an existing folder by clicking and dragging or create a new folder in which to place the bookmark.

Using the Student Information System (SIS)

The Student Information System, or SIS, allows you to:

· Register on-line, view your class schedule, and add and/or drop classes

· View the Registrar's listing of your campus and home address information

· View your grades and the academic calendar

· Retrieve your various balances and account information

· View general information from the Financial Aid Office

· Visit the Academic Advising Site, which provides academic advising information, as well as study tips

Accessing SIS from RPInfo

To access the Student Information System, click on either the Student Information System or Registration/Add/Drop link under the "academic information" section of the RPInfo homepage.  Alternately, you can enter the following URL in the Address or Location field at the top of your browser's window:


http://sis.rpi.edu

Whichever method you use, the Student Information System page will appear.  You may access the information that appears under "Important Stuff" and "Class Hour Schedules" without entering a password to authenticate yourself, but you will need to enter your Student Number and PIN (Personal Identification Number) if you select the Student Information or Faculty and Advisor Information links.  Please note that your Student Number and PIN are different from your RCS password.  The SIS webpages will provide you with a lot of on-line help to guide you through the registration process.  If you forget your PIN, go to the Registrar's office for a new one.

Safeguarding Your RCS Account and SIS Information

It all comes down to keeping your PIN and password confidential.  The first time you use the SIS system, you must change your PIN to a six-digit string that only you know.  And, as with your RCS password, you should not share this information with anyone.

Using WebCT:  Web-Based Coursework at Rensselaer

Web Course Tools (WebCT) is a suite of tools developed by the University of British Columbia to deliver sophisticated Web-based courses.  Currently being used by universities and colleges all over the world to deliver on-line learning, WebCT provides a learning management system that allows Rensselaer instructors to make their course materials and activities available to students. 

Faculty and students at Rensselaer are finding value and convenience in WebCT's many web-accessible functions, such as threaded discussion groups, the table of course contents, on-line quizzes, and a shared calendar.  Staff members in Academic Computing Services (ACS), the Anderson Center for Innovation in Undergraduate Education (CIUE), the Folsom Library, and Continuing and Distance Education are available to assist faculty and students with the use of WebCT.

You can access WebCT course information on-line via RPInfo.  To do this, select the WebCT Courses link from the "Academic Information" section of the main RPInfo homepage.  The page that appears gives a brief explanation of how WebCT is used in coursework here at Rensselaer, and provides links to a variety of different departments that are using WebCT courses.  Other links provide users with access to a quick reference guide and an overview of available WebCT functions.  

Please refer to the URLs below for more specific help and information on using WebCT.

For General Information about WebCT at Rensselaer:

http://www.rpi.edu/dept/acs/webct/webct_at_RPI.html

For Course Listings: 

http://webct.rpi.edu:8900/

For Quick Reference Guides: 

http://www.rpi.edu/dept/acs/webct/qr.html

To access Academic Computing Services' self-study courses on WebCT:

http://www.rpi.edu/dept/acs/workshops/

Leaving RPInfo
When you finish using RPInfo, be sure to exit the application properly.  To do this:

· From either Netscape on a UNIX workstation or Netscape Communicator on a PC, pull down the File menu and select the Exit option.

· From Internet Explorer on a PC, pull down the File menu and select the Close option.

Alternatively, you may click on the Close (X) button on the title bar or press Alt-F4.

Sharing Files across RCS

Using sambasrv

The RCS server, sambasrv, connects Windows machine to the networked campus printers and to the RCS files.  Before you can print from Windows 95, Windows 98, or Windows NT systems, you must first authenticate yourself by entering your RCS userID and password, then connect to RCS through sambasrv.

You must also specify a specific printer and have the necessary printer drivers on your PC in order to print.

The sambasrv.rpi.edu server allows you to access UNIX directories and files from your Windows PC by translating between UNIX and Windows to make the files appear as if they're on an additional PC drive.  

Logging in

To log in on a Windows 95 or Windows 98 machine:

1. In the "Enter your network password for Microsoft Networking" dialog box, type your RCS userID at the User name: prompt and press the Tab key.

2. Type your RCS password at the Password: prompt and press the Enter or Return key.

3. Double-click on the RCS icon on the desktop; a Connect to RCS window will appear.

4. Enter your RCS userID in the "Enter your RCS username" field and click OK.

5. Enter your RCS password in the "Enter password for userid" field, and click OK.

6. A Connect to Rensselaer Resources window should appear.  Click on either (or both) of the check boxes that allow you to connect to your UNIX home directory or to the UNIX public areas, then click the OK button.  You must click on one!)

To log in on a Windows NT machine:  

1. Enter rcsguest at the User name prompt; do not enter a password at this time.

2. Double-click on the RCS icon on the desktop; a Connect to RCS window will appear.

3. Enter your RCS userID in the "Enter your RCS username" field and click OK.

4. Enter your RCS password in the "Enter password for userid" field, and click OK.

5. A Connect to Rensselaer Resources window should appear.  Click on either (or both) of the check boxes that allow you to connect to your UNIX home directory or to the UNIX public areas, then click the OK button.

Mapping a Network Drive

To map a network drive, right click on either My Computer or the Network Neighborhood icon on the desktop and select the Map Network Drive… option from the sub-menu that appears.

The Map Network Drive window appears, as shown below.
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Type in the network path (e.g., \\sambasrv\public) in the Path: field.

The system may prompt you to enter a password in order to connect to either the public space or your RCS space.  If so, enter your RCS password and click on the OK button.

Enabling File and Print Sharing

If you wish to enable file and print sharing on your laptop, open the Start menu, select the Settings option, and then select the Control Panel option.  In the window that appears, double-click the Network icon, and then click on the File and Print Sharing… button.  In the window that appears, click in either (or both) of the file and print sharing options, and click the OK button.  Please note that your enabling this feature does not actually share any resources on your laptop; you need to configure your laptop further to do that.

Finishing Up and Logging Out

Wherever you're working on campus, it's a good idea to save all of your work and quit out of all applications.  If you're working at a PC, you should also consider copying any files that you want to save to either a floppy disk or over to your RCS UNIX file space.

To log out from a Windows 95 machine: Double-click the Logoff icon, which looks like a door with an arrow, located in the bottom right corner of the desktop. Double-clicking this icon will remove any files you created from the machine, as well as remove any access to files in your RCS UNIX file space, if you accessed them.

To log out from a Windows 98/NT machine: Open the Start menu in the lower left corner of the desktop, and select the Shutdown and Close all programs and log on as a different user options.

Please, keep your account secure…always remember to log off!


   Printing

All the workstation labs/classrooms contain networked public printers which print both PostScript and plain text. You can access these printers from any network-connected PC, laptop, or RCS UNIX workstation. Although most of the printers print in black-and-white, several color and color overhead (transparency) printers are also available.  The VCC houses a printer dedicated to printing labels, as well as a PostScript plotter capable of producing color output on continuous paper 36 inches wide.

Most of the printers are self-service. However, some of the printers in the VCC, such as the duplex printer, the label printer, some of the color printers, and the PostScript plotter, are located in a restricted area. Once each hour, the CIS operations staff places output from these printers in special output racks located in the corridor outside VCC South. (Output from the color plotter has a longer turnaround time.)

CIS Public Printers

Networked PostScript printers are located in many places across the campus, including the VCC, all the workstation lab/classrooms, and the various PC labs.  Most of the CIS public printers, including those in the residence halls and the computer labs, are black-and-white printers that produce letter-size PostScript output at six cents per page and two cents per job.  

The PrinterChooser application on RCS UNIX systems has some information on the individual printers, but we've provided some details, including printer name and printing cost, about some of the more specialized printers below.

VCC Print Room Printers

Printer



Printer Name


Printing Cost

QMS 3225 duplex
               vclw      (400dpi)  two-sided:  8 cents/page + 2 cents/job

                                             



 one-sided:    5 cents /page + 2 cents/job

VCC laserwriter                  
vclbl30   30-up labels
     25 cents/page  + 10 cents/job

Color Printers

Printer




Printer Name
Printing Cost

CII 3112 Phaser III            

ci3112p3    
$0.40/page

CII 3111 200i                  


ci200let     
$0.50/page + $.20/job

CII 3111 200i Overheads        

ci200ovr     
$1.00/page + $.20/job

CII 3116 Phaser 200i           

ci3116p2     
$0.50/page

CII 6208 Phaser 200i           

ci6208p2    
$0.50/page

JEC 3207 Phaser III
       

ec3207p3
$0.40/page

VCC Phaser III - Lobby         

vcpap3       
$0.40/page

VCC Phaser III - Printroom     

vcph3let     
$0.40/page + $.20/job

VCC Phaser III - VCC South     

vcsop3       
$0.40/page

VCC 200i Paper  - Printroom    

vc200let     
$0.50/page + $.20/job

VCC 200i Overheads - Printroom 
vc200ovr     
$1.00/page + $.20/job

VCC 2-SDX - Printroom          

vcsdxlet     
$3.75/page + $1/job

PostScript Plotter
Printer




Printer Name
Printing Cost
VCC HPDesignJet 755CM -      

vcplt        
$0.75 to $1.75/foot, 

    
      Printroom                                



    based on options selected
Printer Naming Conventions

Printer names on the RCS network consist of three parts, usually {building}{room}{type} or {building}{type}{form}.  The short form of the name uses a two-character building code, up to four characters for a room, location, or type, and a two-character type or form code.  

Some of the more common printer types and forms appear on the following page.

Printer Types and Forms

LW  A Lexmark Optra or similar black-and-white letter-size PostScript printer.

P3  A Tektronix Phaser 340 or 350 or similar color PostScript printer that prints on letter-size paper.

200 or P2  A Tektronix Phaser 200I color PostScript printer that uses either letter paper (LET suffix, or no suffix) or transparencies (OVR suffix). 

SDX  A Tektronix Phaser 2 SDX color PostScript printer.  Due to the dye sublimation process, this printer produces output with excellent, near-photographic quality.

LBLxx  A black-and-white PostScript printer that prints labels.  LBL stands for "label"; the xx indicates the number of labels per page.

Examples

You're bound to become familiar with the various printer names as you print more and more documents, but we've provided a few examples here to give you a general idea of how the names work.

The printer name ci3112p3 follows the {building}{room}{type} convention; ci represents the CII (Center for Industrial Innovation), 3112 is the room number, and p3 indicates that the printer is a Tektronix Phaser III.

The printer name vcsdxlet follows the {building}{type}{form} convention.  The vc indicates that the printer is located in the VCC (Voorhees Computing Center), sdx indicates that it is a Tektronix Phaser 2 SDX printer, and let indicates that the printer produces letter-size output.

Printing Allocations and pagestatus
At the start of each fall and spring semester, you will receive a free allocation of $12.50 for black-and-white printing; if you use up this allocation, you will be billed for any additional printing charges.

Please note that this printing allocation does not cover color printing; you will always be billed for this.
To see how much is left in your printing allocation, start a UNIX session (you can use SecureCRT for this), and issue the following command from a UNIX prompt:

pagestatus

The information that appears on the screen will list all of your most current print jobs:  what you printed and where, etc.  At the bottom of all of this information, you should see a line reading something like "Remaining page allocation for <   > on <date> is <$$$>."  Divide this figure by 8 cents (to allow for various printing costs) to determine approximately how many more pages you can print free-of-charge.

Choosing a Printer and Printing from Public PCs

Authenticating Yourself

To print from a public machine, you must have first authenticated yourself by entering your RCS userID and password at the login prompts when you started working at the machine.  (Please refer to the "Logging In" section of this document for instructions on how to do this.)


Printing from an Application

In most cases, you can select the Print option from an application's File menu to send your file to the printer.

In the dialog box that opens, the name of the default printer should appear. (Make a mental note of this, so you will know where to pick up your output.)  You can select a different printer by clicking on your new choice from the pull-down list of available printers. Then, click OK to send your job to the specified printer. 
Checking the Print Queue

To check the queue on a specific printer, start a SecureCRT session to rcs.rpi.edu and use the lpq command from a UNIX session, as follows, where printname refers to the name of the specific printer:


lpq -Pprintname

For example, you would enter the following to check the queue for the printer located by the stairway on the main floor of the Folsom Library:

lpq -Pli2f1lw

Similarly, you could type either of the following commands at a UNIX prompt to check the print queues for either of the printers on the first floor of the Folsom Library:

lpq -Pli1f1lw

lpq -Pli1f2lw

Installing a Printer Driver

To add a local printer (one directly connected to your laptop or desktop):

1. Double-click on the My Computer icon, double-click on the Printers folder, and then finally double-click on the Add Printers folder.  The Add Print Wizard will start; click on the Next button, select the Local printer option, and click on the Next button.

2. Select the printer manufacturer and printer type (e.g., Apple-LaserWriter Pro 630).  If prompted, insert the printer CD or point to windows/options/cabs where Windows 95 is located on laptop.

3. Type in the printer name, and specify if you choose to use this as your default printer.  The printer name is user selectable. Click on the Next button.

4. The system will prompt you to print a test page.  Make your selection and click on the Finish button.
To add a sambasrv (network) printer:

Follow the same steps given above, but select the Network printer option (instead of Local Printer) in step 1.  Also note that in order to print to a network printer, you will need to log in to your machine and authenticate yourself with your RCS userID and password.

If you have any problems, refer to Quick Study #16, Printing from RCS.

For More Information…

You can find additional printing information, including a list of public printers, on-line via RPInfo.  To do this, select the Academic Computing Services link from the "Computing" section of the RPInfo homepage, then select the Printing link from the ACS homepage that appears.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/Computing/Consulting/Printing/printing.html
  CIS Resources and Services

While here at Rensselaer, you will probably find many of the following to be invaluable resources and services.  For much more information about these and other CIS resources and services, please refer to the CIS homepage by selecting the Computing & Information Services (CIS) Home link from the "Computing" section of the RPInfo homepage, or by entering the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/cis

Computing Labs

Rensselaer's campus houses hundreds of computers for you to use: these are mostly Wintel PCs, and SGI and IBM UNIX workstations.  Other labs across campus contain connections for laptop computers. 

Regular Lab Hours

For a listing of regular lab hours, by lab or building, select the Academic Computing Services link from the "Computing" section of the RPInfo homepage, then select the Schedules/Maps link from the ACS homepage that appears.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/Computing/Labs_maps/Hours/hours.html.  

Special Lab Hours

Please note that lab hours may change during exam weeks, over the summer, and during holiday breaks.  For a list of these hours, select the Academic Computing Services link from the "computing" section of the RPInfo homepage, select the Schedules/Maps link from the ACS homepage that appears, then select the special hours link.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/Computing/Labs_maps/Hours/holiday-hours.html 

Labs and Available Software

For a complete listing of CIS PC computer labs, as well as what software is contained in each lab, select the Academic Computing Services link from the "Computing" section of the RPInfo homepage, then click on the PC Labs/Software link from the ACS homepage that appears.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/dept/acs/pcinfo/pcinfo.html
Laptop Lab Locations

The following campus labs will house laptop jack connections.  An asterisk (*) indicates that the room will act as a "hybrid" lab that will house both laptop connections and desktop PCs.

Amos Eaton 215


JRSC 2C14 *


Sage 2411

Amos Eaton 216


JRSC 2C22


Sage 2715

CII 4034



JRSC 2C30


Sage 3101 *

CII 4040



Lally 002


Troy 2012 *

Greene 014


Lally 102


Troy 2018

JEC 3204


Lally 104


VCC South *

JEC 4304 *


Pittsburgh 4114 *


Walker 5113 *

JRSC 2C06 *


Pittsburgh 4206


Walker 6113 *

The Campus Computer Store

Rensselaer's Campus Computer Store, located on the main floor of the Voorhees Computing Center and operated by CIS, is a non-profit computer store that establishes educational agreements with manufacturers and thereby is able to offer hardware, software, and computing accessories to the Rensselaer community at competitive prices.  The store also offers pre-sales consulting to Rensselaer students, faculty, and staff, as well as advice for helping customers determine their present and future computing needs.   

For more information on the Campus Computer Store, select the Campus Computer Store link under the "Computing" section of the RPInfo homepage.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/dept/computer_store
Academic Computing Services

Academic Computing Services (ACS) offers many important computing-related resources, such as maintaining computer labs all across campus, giving technical and consulting help, offering short courses on various computing topics, providing on-line and paper documentation, and maintaining and distributing the CIS newsletter, The Kiosk.
ACS also has its own webpage; to access it, select the Academic Computing Services link from the "Computing" section of the RPInfo homepage.  Alternatively, you may enter the following URL in the Address or Location field of your browser window:

http://www.rpi.edu/Computing/ACShome.html

Rensselaer Computer Repair

CIS' Rensselaer Computer Repair (RCR) provides a resource for the repair of computers and peripherals, and supports the CIS Campus Computer Store by providing warranty service on IBM, Dell, and Apple computers.  RCR will also repair out-of-warranty computer equipment and peripherals such as laser and ink jet printers, and also offers annual service contracts to Rensselaer departments and faculty for their computer equipment installations.

Other RCR services include upgrades, memory and hard disk installation, driver and patch installations on PC and laptop machines, computing lab equipment and security device installation, repair, and preventive maintenance on major brands of laser printers.  RCR also offers laptop repair, should your machine ever require service, and has a number of loaner laptops available, so chances are you'll have a machine to use to keep up with your coursework.

If you have a problem with your computer hardware, please contact RCR by phoning ext. 7777 to register a trouble call with the Help Desk.  You may also contact RCR directly by phoning ext. 8178 or by directing electronic mail to repair@rpi.edu.  

RCR also has its own webpage; to access it, select the Academic Computing Services link from the "Computing" section of the RPInfo homepage, then select the Personal computer repair link.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/dept/cis/rcr/RPInfo/
Telecommunications

The Telecommunications office, located in Room 215 on the main level of the Voorhees Computing Center, provides a variety of phone-related services, including:

· Telephones and related equipment.  All student residence hall rooms come equipped with working telephones.  If the phone in your room isn't working properly, please call the Help Desk at ext. 7777 to place a trouble ticket.  If you are missing your telephone altogether, or if you are missing a telephone cord, you may pick these items up in the Residence Life office.

· Voice mail.   Having voice mail is like having your own personal phone-answering machine, 24 hours a day, and Telecommunications provides this service to you free-of-charge.  You should have received your voice mailbox number, password, and setup instructions at home in the mail sometime during the summer.

· Pre-paid calling cards.  You can purchase a prepaid calling card from the Campus Computer Store, located on the main floor of the Voorhees Computing Center, or from the Rensselaer Union Bookstore, located on the lower level of the Student Union

· Long-distance calling authorization codes.   Telecommunications provides long-distance calling service via the use of a confidential nine-digit calling code, which you will receive at your home along with your voice mail information.  Please remember to keep this code in a safe place, and never give others access to your authorization code.

If you lose your authorization code, contact the Telecommunications office immediately at ext. 6258 during the regular business hours shown below; after business hours, call the VCC Help Desk at ext. 7777.  If you forget your authorization code, you will need to stop by the Telecommunications office in person.  Please be sure to bring your valid Rensselaer ID card with you.

Long-distance rates for calls within the continental United States are ten cents per minute, any day or any time.  International rates will vary, based on what country you are calling, so please contact the Telecommunications office at ext. 6609 if you have questions about international rates. 

Billing for long-distance, operator-assisted and collect calls will appear on your tuition bill, and all payments will be credited to your tuition bill as well.  Every month, Telecommunications will send a listing of your telephone calls to your on-campus address. 

Telecommunication business hours are 8:30am - noon and 1:30pm - 4:30pm, Monday through Friday, with the exception of staff holidays.  

If you would like more information about Telecommunications and its services, please direct electronic mail to telecom@rpi.edu, or call the Business Office at ext. 6258.  You can also access Telecommunications' homepage via RPInfo; to do this, selecting the Computing & Information Services (CIS) Home link from the "Computing" section of the RPInfo homepage, select the Telephone Services link, and finally select Telecommunications Home Page.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/dept/tele/

The Rensselaer Libraries

The Rensselaer Libraries, which consist of the Folsom and Architecture Libraries, offer a number of important resources, including:
· Class Reserves.  The Class Reserves database on the web lists materials held at the Libraries' Circulation Desks for specific courses. Using Adobe's Acrobat®, Class Reserves also scans material for instructors to be made available in PDF format.  Whenever possible, Class Reserves also provides links to faculty-maintained course pages.

Reserve materials are listed alphabetically by school, then alphabetically by department. 

Within these departmental listings, materials are put in order according to the Registrar's course numbering system; please use the green "Item [number]" that follows the course description when requesting material from the Circulation Desk.  

In addition, please keep the following numbering schemes in mind when requesting materials:

· Library books on reserve are in call number order. 

· Class materials (homework, notes, exams and photocopies of readings from journals) are in numbered folders and should almost always start with item 01 and proceed from there up to 199. 

· Instructor’s personal copies of books and manuals are numbered 200 to 299. 

· Audio/Visual Materials (videos, cassettes, CDs and software) are numbered 400 to 499 or have a library call number.  

· Professional & Distance Education lecture tapes are numbered 500 to 599.  

If a course does not appear, it generally means that no "Class Reserve" materials exist for it, and/or that a course page has not been reported to the library. (If it is very early in the semester, the materials may not yet be available.  However, the Library staff works hard to process all class reserve materials as soon as possible, so check back for them regularly.) 

For more information on Class Reserves, select the Class Reserves link from the "Libraries" section of the RPInfo homepage.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:


http://www.lib.rpi.edu/dept/library/reserves/index.html

· Folsom Library's Reference Desk.  Located on the main level of the Library, the Reference Desk has the following hours, with the exceptions of holidays and periods when classes are not in session:

Monday - Wednesday

10:00am - 6:00pm and 7:00pm - 9:00pm

Thursday


10:00am - 7:00pm

Friday



10:00am - 5:00pm

Saturday


Closed

Sunday



1:00pm - 5:00pm

· Public Access Workstations.  The Folsom Library houses several UNIX workstations and Macintosh computers on the first floor, a PC lab on the second floor, and many newly-installed laptop network connections on the third and fourth floors.

· RensSearch.  The Libraries' information system, known as RensSearch, is a Web-based user interface that ties together all of the Libraries' information resources and services, and that also allows the Libraries to provide access to new information resources, such as full-text databases and electronic publications.  Via RensSearch, the Libraries can also provide existing library services, such as instruction and tours, electronically.
You may access RensSearch on-line via RPInfo; to do this, select the RensSearch link from the "Libraries" section of the RPInfo homepage.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

http://www.lib.rpi.edu/dept/library/html/LibInfo.html

· Short Courses.  Periodically throughout the school year, the Rensselaer Libraries offer short courses on how to access and use the many different databases the Libraries have available.
· Survival Guide.  Need to get to your professor's course reserve materials?  Find your Library PIN?  Check library hours?  Sign up for a group study room?   The Libraries' Survival Guide is a one-page guide that provides answers to the most frequently-asked questions, as well as brief descriptions of the most popular Library services.  URLs direct users to additional information and more detailed service descriptions.
The Survival Guide is available in both the Folsom and Architecture Libraries.  An on-line version is also available via RPInfo; to access it, select the RensSearch link from the "Libraries" section of the main RPInfo homepage, then select the Instruction link, and finally the Library Survival Guide link.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:


http://www.lib.rpi.edu/dept/library/html/instruction/guides/survival.html

Scanning and Digital Video Capabilities

Scanners are available in the VCC lobby and in Sage 4510.  CII 3111 houses two Dell Optiplex machines running Windows NT, each attached to a Umax Astra 2400S scanner.  These scanners use the OmniPagePro software to enable Optical Character Recognition (OCR).  The VCC Help Desk has an Apple One scanner attached to a Macintosh; this scanner also uses OmniPage to allow for OCR capability.

For more specific information on how to use the scanners ACS has available, please refer to Memo 126, Scanning Images and Text, located in the documentation racks outside the VCC Help Desk.  This memo is also available on-line via RPInfo; to access it, select the Academic Computing Services link from the "Computing" section of the main RPInfo homepage, then select the ACS documentation link from the ACS homepage that appears.  Memos and Quick Studies are listed by both topic and by number.  Alternatively, you may also access the documentation by entering the following URL in the Address or Location field at the top of your browser window:

http://www.rpi.edu/Computing/Docs/docs.html  

Video stations are also available in both the VCC lobby and in CII 3111.  These machines' most basic use is for capturing video from a VHS videotape and saving it as a Video for Windows file for playback on most Windows machines, but they also offer users the ability to:

· Capture multiple clips and assemble them into a movie, using Adobe Premiere

· User transitions, filters, titles, and special effects

· Save the movie as a Quicktime file rather than a Video for Windows file

· Write the edited movie back out to video tape

· Use the Sony Hi8 VCR (available only in CII 3111), as well as the Panasonic AG-1980 S-VHS VCR

· Read (and write) DV tape from your digital camcorder using the Pinnacle DV300 digital video card

The video stations are available whenever the VCC and CII 3111 are open.  However, if demand for the stations becomes heavy, we may need to establish a sign-up procedure.

A preliminary Quick Study document, available on the desktop of the machines, provides instructions on capturing video from a VHS videotape and saving it as a Video for Windows file for playback.  If you plan to use this capability, you should plan to bring your video material on a VHS tape, as well as a Zip disk on which to store the results, so you can take them away with you.

  Campus Computing Network Information

Facilities Overview 
In addition to the various PC and UNIX labs currently existing in the CII, JEC, Lally, Pittsburgh, Sage, Troy, the VCC, and Walker, a number of laptop-ready labs are available across campus.  (Please refer to the laptop lab listings given in the "CIS Resources and Services".)

ResNET

ResNET is the high-speed Ethernet network service that is available in all of the residence halls.  And because it's a bundled service, this means you don't have to make any special requests to have the service activated, nor are you charged any special fee for the service (beyond that already included in the room fees).  Live network ports are available in every residence hall room, with one port for each occupant.  

Here's all you'll need to connect to the network:  (Freshmen laptops are already equipped with these features.)

· A personal computer with an Ethernet adapter (CIS supports IBM PC-compatible systems and Macintosh)

· TCP/IP network software for your computer (such as Windows 9X/NT or MacOS)

· A "10-base-T" network cable (these are available in the Campus Computer Store)

Automatic Host Configuration

Automatic network configuration of your computer using the Dynamic Host Configuration Protocol, or DHCP, is the default on the ResNET network.  DHCP, which allows a server to dynamically distribute IP addresses and configuration information automatically when you boot your computer, provides your computer with the following basic information:

· IP address and subnet mask

· Default gateway or router

· Domain Name Server (DNS) addresses

· Windows Internet Name Service (WINS) server addresses

· IP Domain name

DHCP configuration is an easy and foolproof method of configuring the network parameters on your computer; you should use this service whenever possible.  (The laptops that Rensselaer will provide to the students will already be equipped with DHCP.)

Static IP Addresses

If your computer does not have a DHCP client, and automatic configuration is not possible, a static IP address can be assigned to your computer, meaning that you will not be able to move your computer to other areas of the ResNET network. 

To request a static IP address, please submit a “Request for Static IP Address” form, available at the VCC Help Desk. The form is also available on-line; to access it, select the Academic Computing Services link from the "computing" section of the main RPInfo homepage, select the ACS forms link, then select the ResNET Static IP Request Form link.  Alternatively, you may enter the following URL in the Address or Location field at the top of your browser window:

 http://www.rpi.edu/Computing/Docs/Forms/forms.html

NetBIOS Names

If your ResNET computer uses a Windows operating system, you have already been asked to set the System Identification to be the same as your RCS userID. It is important for the proper operation of Windows networking that the NetBIOS or “System Identification” name be unique among other users on the network. The best way to ensure uniqueness is by using your RCS userID.

  Everything You Always Wanted to Know about UNIX 
  but Were Afraid to Ask…

In addition to the many personal computer labs on campus, there are public labs containing UNIX workstations and several UNIX machines available for remote access. While you might not use the UNIX platform for most of your work here, there are some tasks that can only be done from UNIX, and you may find it helpful to know some basics. This section will provide you with some simple UNIX commands and an elementary knowledge of the UNIX file structure.
Establishing a UNIX Session 

From a UNIX workstation: After logging in with your RCS userID and password, go to the RCS Applications menu and open a UNIX window by clicking once on UNIX: Start a UNIX Window. From this window, you can enter any of the commands described in the following sections. If you are not familiar with UNIX workstations, you might want to work through the exercises in the section "Some UNIX Workstation Basics,” at the end of this document.

Note that the RCS Applications menu also includes a number of commonly-used applications available on UNIX:

· FrameMaker -- A desktop publishing package

· Maple -- A symbolic math package used extensively in Rensselaer's calculus courses

· Matlab -- A numerical analysis package

· Communicator -- Netscape Communicator, a Web browser

· Printerchooser -- A graphical way to select a printer other than the default

· Pro/ENGINEER -- A 3D solid modeling package, used in engineering design courses

· SAS -- A statistical analysis program

· Xess -- A spreadsheet editor

· Z-Mail -- The default electronic mail package on the UNIX platform

When you are finished your UNIX session, be sure to log out by clicking on the Logout option at the bottom of the RCS Applications menu.  Never leave your workstation without logging out!
From a PC: To use UNIX from a PC, first start the SecureCRT program to establish a secure telnet session to one of the remote hosts. After starting the program and selecting a host from the Session List (for example, rcs-ibm.rpi.edu), you will be prompted for your RCS userID and password. When the UNIX window appears, you can enter UNIX commands at the prompt. For details on using this program, please see the section on SecureCRT in Part 2 of this document. 

Note that the SecureCRT connection does not give you access to applications that require an X-windows display, such as FrameMaker and the other applications listed above. For your own computer, it's possible to buy an X-windows emulation program that allows you to use these applications as if you were sitting at a UNIX workstation. 

When you are finished, be sure to log out: first enter logout at the UNIX prompt, and then close the program as usual.

Communicating with UNIX

When you log on to UNIX, you are initially in your home directory. Each RCS userID has a home directory associated with it--your own private space on the RCS UNIX systems. Student accounts are set up with 5 megabytes of disk space in which to store files and directories.  A file is any collection of characters stored together, such as the words in a letter or paper, a computer program, or a listing of data. Files can be grouped together in a directory, which is analogous to a folder on a Windows system. You are the only one who can read and write files in your home directory. Note that you can access your UNIX files from any networked campus PC or workstation.

You communicate with UNIX by giving commands: type the command name and  then press Enter or Return. Using  the commands described in subsequent sections, you can create your own files and directories, manage your RCS account, print files, and more. Some commands take arguments, often a file or directory name, and many commands allow options. An option is a special argument preceded by a hyphen (-) that tells UNIX to execute a certain variation of a command. For example, the command ls lists the files in the current directory, and ls -l (the "long" form) lists them with additional information about each file.

File names, directory names, and command names are case-sensitive in UNIX. This means that myfile and MyFile are two different files. You can use letters, digits, underscores (_), periods (.), and dashes (-) as part of a file or directory name; however, it is best to use a letter or digit as the first character of the name. Do not use spaces in file names. Note that some applications will create directories and files for you; for example, the first time you use FrameMaker, it creates the FrameMaker directory.

Managing Your RCS Account

Several account management tasks, such as changing your password, requesting additional disk space, and forwarding your mail, are conveniently done from UNIX.

Changing  Your Password

In addition to changing your password from the web, as described earlier, it is also possible to change your password by issuing a UNIX command. After you have thought of a good password (that contains exactly 8 characters, contains some characters that are not lowercase letters, is not easy for others to guess and you can remember without writing down), enter the following command at a UNIX prompt:


passwd 

Enter the requested information as prompted. If you wish, the passwd program will provide you with some information on choosing a good password.  

Requesting Additional Disk Space
By default, you are allotted 5MB of disk space in your RCS UNIX account free-of-charge. To check how much of that space you are using, enter the command:


fs  lq
which stands for "filesystem list quota." The amount in the Quota column shows your total disk space (in kilobytes). The percentage is the %Used column shows how much of your alloted space you have used. (The Partition percentage is not relevant to individual accounts.)

If you need more space, you can use the quota_request program to increase your allotment. The charge is  25 cents per megabyte per month for the first 50 MB.  Thereafter, each additional megabyte costs 15 cents per megabyte per month, up to a total of 250MB.

To change your quota, enter the following command at a UNIX prompt, replacing the pound sign (#) with the total number of megabytes you wish to have in your disk space:


quota_request -quota #
For example, to change your quota to 10MB, you would enter the command:


quota_request -quota 10
To reduce your disk space allotment back to its default setting, you would enter the command:


quota_request -reset

Before you issue the -reset request, be sure you have reduced the actual disk space you are using to the account's original default value (or less); otherwise, your request will be denied!  Also keep in mind that it can take up to 24 hours to process your quota request; you should receive e-mail confirming the completed transaction.

Note that you will be charged for your extra disk space whether you are using the account and extra space or not.  Therefore, if you plan to be away for an extended period of time, you should consider reducing your required disk space and disk quota.

Forwarding Your Mail

If  you plan to be away from campus for a while, you may want to have your mail forwarded to another e-mail address. On UNIX, there is a forward program that will do this for you. For example, if you would like your mail forwarded to the new address "myname@work.com", you would enter the following command:


forward myname@work.com

To unforward your mail at a later date, enter the forward command again, this time followed by a pair of quotes with nothing inside:


forward " " 

Note that forward requests are processed once a day, so it could take up to 24 hours before your mail starts to be forwarded.

Printing 

From a UNIX Application

If you are sitting at a UNIX workstation (or using an X-windows emulation program), you can use one of the UNIX applications (such as those listed above) that provide their own windows complete with menus. In this case, you can print by selecting the Print option from an application's File menu just as you would on a PC.

Using the Printerchooser

Again, if you have a windows interface, you also have the option of using the printerchooser application, which displays the names of the printers and provides an easy, graphical way to choose a printer. 

From the RCS Applications menu, click on  printerchooser:  View and select printers. A separate Select a Printer window will appear on the screen. Click on the desired printer name from the displayed list; you can then choose to use that printer for the current session only, make it your permanent default printer, ask for information about the printer, cancel print jobs, or look at the queue.  If you need help, just click the Help button. 

Please note that if you are using an application that allows you to select a specific printer, your choice in that application will override any printer you may have selected using printerchooser.

Printing Using UNIX Commands

No matter how you are connected to UNIX, whether it's via SecureCRT or via a UNIX workstation, you can always use the standard UNIX printing commands, lpr, lpq, and lprm. These commands, entered at a UNIX prompt, are shown below.

Command
Action
lpr  myfile
Prints the file myfile, assuming it exists in your current directory.

lpq

Displays the print queue, including the job numbers.

lprm  nnn
Removes your job (number nnn) from the queue.

Each computer location has a default printer. For example, if you are working in one of the workstation labs, the default printer will be the one in that room. To display your lab's default printer name, use the Verbose option on the UNIX lpq command (note the uppercase V):


lpq -V     

The UNIX commands shown above all allow you to specify a printer other than the default by using the -P option.  For example, if you wanted to print the file myfile on the VCC's duplex PostScript printer, vclw, you would issue the following command from a UNIX prompt:

     
 lpr  -Pvclw  myfile
And to check that printer's queue, you would issue the command:

lpq  -Pvclw

Checking your Printing Allocation

Each semester you are allowed $12.50 worth of black & white printing free of charge. To check how much of  your printing allocation you have used, enter the command:

pagestatus
UNIX Files and Directories

UNIX files are organized in directories. Your home directory is just one branch of a much larger directory tree that contains many other directories, such as other users’ home directories, documen​tation directories, and application directories. 

File Access

Other users can see only the names of files and subdirectories in your home directory, not their contents. However, you can share directories and files with other users in several ways. One method is to per​mit a directory so other users can access the files in it. Memo RPI.114, Sharing Files in RCS UNIX, explains how to permit files and directories to other users. But the easiest way is to use the special-access subdirectories already in place in your home directory. You can use these directories to hold files that you wish to share with others or files that you wish to hide. 

· public - Files in this directory can be read by everyone (the public). Put files you want to share in this directory.

· public_html - Put your World Wide Web homepage in this directory. Usually, the name of the homepage is index.html.

· private - This directory cannot be read by anyone except the owner (you). Even the file names are hidden from other users. Store sensitive files in this directory. 

· yesterday - This directory contains a “snapshot” of your files taken at the time of the last backup. RCS backups are done 4 times a week. If you accidentally delete a file, you may find a backup copy in this direc​tory and copy it to another directory. Files in this directory and its subdirectories do not count as part of your disk quota. You may not write to this directory.

A Sample Home Directory Tree

A fictional home directory belonging to a person with the userID doej is pictured below. Note that files and directories may both exist at any level. It is not possible to tell by looking at a name whether it represents a file or a directory. (Some people capitalize the first letter of directory names to distinguish them from file names.)

doej

 math1      resume           public     public_html     private          yesterday   

      hw1.msw   hw2.msw            team_project      index.html        letters               

             

traffic.data    bridge.data               mother      fido

In this example, user doej has created some other files and directories. He has stored his résumé in a file named resume, and the directory named math1 holds the Maple files hw1.msw and hw2.msw, homework assignments for a calculus course. His public directory contains a subdirectory named team_project containing two data files (traffic.data, bridge.data) that others can read. The private directory contains the subdi​rectory letters, with two files, mother and fido.

In the directory structure above, doej is the parent directory of public, which is in turn the parent directory of team_project. 

Paths

A path, which is the complete name for a file, lists the chain of parent directories that lead to a file, plus the file name, separated by slashes (/). For example, the complete path for the fido file (as shown in the above diagram) is 


~doej/private/letters/fido
In order for other users to access your files, and for you to access other users’ files, the complete path to the file must be specified. UNIX defines some shortcuts that come in handy in writing paths:

 
/ 
the root of a filedirectory tree
     
.
the current directory
     
..
the parent directory 
     
~
your home directory
     
~doej
user doej's home directory

Some Basic UNIX Commands

Commands Affecting Directories

Whenever you use UNIX, you are working within a specific directory, known as your working directory or your current directory. Because the commands you issue will affect this directory (unless you specify otherwise), it's important to know what it is. To find out what directory you are in, enter the command:


pwd
which stands for "print working directory."  On RCS, the name of the working directory is also usually contained in the UNIX command prompt.

Use the ls command to list the names of  the files in the current directory. Note there are several options you can use with the ls command. To create a new directory, use the mkdir command, to move to a different directory, use the cd (change directory) command, and to remove an empty directory, use the rmdir command.  Some examples appear below.


ls
List the files and directories in your home directory


ls -F
Show file types (directories have a "/ " appended)


ls -l
Show details such as file size and date last modified


mkdir  temp
Create a new subdirectory named temp

cd  temp
Change from your home directory to the temp directory



Note the UNIX prompt change.

pwd
Display the name of the current directory

cd  ..
Move to the parent directory 


    
Enter this as cd (space) (period) (period)

rmdir temp
Remove the temp subdirectory


cd  public
Move to your public directory


cd  ~millem8/public
Move to user millem8’s public directory

ls
List the files in millem8's home directory

cd
Move to your home directory

Commands Affecting Files

The mv (move) command either gives the file a new name or moves it to a new location, and  the cp command copies the file, leaving the original untouched. These two commands work in the same way, as illustrated in the examples below. The rm (remove) command deletes a file. When copying, moving, or deleting a file, make sure that no other file with the same name already exists. UNIX does not warn you before executing these commands, and if you're not careful, you could overwrite another file or unintentionally delete something. If you would like UNIX to ask you before executing the command, including the -i (interactive) option will prompt you for confirmation.
To view the contents of a (text) file, use the more command, which displays the file one screenful at a time. To display the next screenful, press the spacebar. To stop viewing the file before it's finished, type q (quit), or press ctrl-c to abort the command.

Other useful commands are: grep, which searches for a specified string of characters inside a file; ispell, which checks the spelling of the text in a file; sort, which alphabetizes the lines of a file; and wc, which counts the lines, words, and characters in a text file. Some of these commands are most useful when used with special UNIX characters, such as *, the wildcard character, and the redirection characters, < , >,  >>. The examples below show how to use these commands and special characters.  


more ~millem8/public/troy
Display the contents of millem8's public file called "troy"


cp ~millem8/public/troy  firsts
Copy the file "troy" to your directory and call it "firsts"


mv  firsts  troy-firsts

Rename your file "firsts" "troy-firsts"


grep  Rensselaer  troy*

Search for "Rensselaer" in all files starting with "troy"


sort  troy-firsts  > troy-sorted
Sort the lines in troy-firsts, put the result in troy-sorted


more  troy-sorted

View the sorted file (ugh!)


more troy-firsts >> troy-sorted
Append the file troy-firsts to the file troy-sorted


rm  -i  troy-sorted

Delete the file troy-sorted, but prompt first


wc troy-firsts

Display number of lines, words, characters in troy-firsts


man ispell 

Read first part of man page for hints on how to use ispell 


ispell troy-firsts

Spell check the file troy-firsts

To change the contents of a file, you need to use an editor. The three most commonly-used UNIX editors on RCS are vi, emacs, and nedit. Memo RPI.113, Using UNIX: The Rensselaer Com​puting System,
has sections on how to use each of  these editors. Note that both vi and emacs can be used if you are logged on remotely (via SecureCRT), but to use nedit you must be using a UNIX workstation or running an X-windows emulation program.



For More Information About UNIX…

In case you haven't learned all you want to know about UNIX, Memo RPI.113, Using UNIX: The Rensselaer Computing System, explains in detail how to use UNIX on RCS. Quick Study #2, Useful UNIX Commands, contains a list of basic UNIX commands. You can pick up copies at the VCC Help Desk or view them on-line in RPInfo by selecting the Academic Computing Services link from the main RPInfo homepage, and then selecting the ACS documentation link from the ACS homepage that appears.

You can also learn more about UNIX by taking the “Introduction to UNIX” course, which ACS offers from time to time — usually at the beginning of the fall and spring semesters. To find out about the schedule for ACS short courses, ask at the VCC Help Desk, or check in RPInfo by selecting the Academic Computing Services link from the main RPInfo homepage, and then selecting the Computing short courses link from the ACS homepage that appears.

If you're logged on to UNIX, you can also take advantage of the on-line manual pages, often referred to as "man pages." For example, you may want to find out more about the ls, lpr or forward commands. To view more information about the forward command, you would enter the following command at a UNIX prompt:


man forward
The man page entry for the command will appear on your screen. To move to the next screen of the entry, press the space bar; to quit the entry, type q.  

If you would like more information, there is actually a man page on man pages!  To access it, enter the following command at a UNIX prompt:


man man

   Some UNIX Workstation Basics

Using a UNIX Workstation

Logging in

If you go to use a UNIX workstation and the screen is blank, try pressing any key on the keyboard, or moving the mouse.  Chances are good that the screen saver had been activated, and that's why the screen was blank.  

To log in, first type your RCS userID at the prompt and press the Return key, then enter your password at the next prompt, and press the Return key. Note that your password does not appear as you type it and the cursor doesn't move.

The login process does not vary from UNIX workstation to UNIX workstation, although the login screen and the prompts may be different.

When you log in, a clock and a mailbox icon appear in the upper right-hand corner of the screen with the RCS Applications menu below them. A Session Manager window also appears in the lower left-hand corner. 

A msgs window, which displays on-line system bulletins and other important announcements, may also appear. The contents of the first message will automatically appear in the lower portion of the window. If other bulletins exist, and you wish to read them, position the mouse cursor over the Next Bulletin button and click the left mouse button. To skip the current message, left-click on Abort, or left-click on List All for a list of all existing system bulletins. To exit the msgs window entirely, left-click on Done. 

Using the Mouse 

Unlike the mouse on a PC, which has two buttons, a UNIX workstation's mouse has three to provide additional functionality for some programs, such as pro/ENGINEER, but it works in the same way in that moving the mouse moves the cursor on the workstation screen.  Experiment with the mouse until you feel confident that you can use the mouse to point to a number of items on the screen. Note that, as on a PC, the left, middle, and right buttons are defined with the mouse-connecting wire pointing away from you.  Also notice how the cursor changes shape as it moves in and out of windows.

You will use the mouse in various ways, as defined below:

· Left-clicking -- Rapidly pressing and releasing the left mouse button

· Double-clicking -- Rapidly pressing and releasing the left mouse button twice

· Dragging -- Holding down the left mouse button while moving the mouse. As you will see in subsequent sessions, you will find this useful when manipulating windows.
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The Three Buttons on a UNIX Workstation Mouse


Opening the printerchooser Window 

Start printerchooser by left-clicking once on the printerchooser: View and select printers option in the RCS Applications menu. It might take a while to open, so please be patient and only click this option once; otherwise you will end up with multiple versions of the same application. Using printerchooser is explained earlier in the "Choosing a Printer and Printing Using UNIX Commands" section of this document.

Opening a UNIX Window

Open a UNIX window by left-clicking on the UNIX: Start a UNIX Window option in the RCS Applications menu. You will enter UNIX commands in this window.

The top of the window is called the titlebar, which contains the name of the workstation.

Resizing a Window 

To resize a window, move the cursor to the edge of the window; notice that it changes its shape. You can make the window larger or smaller by pressing and holding the left mouse button as you drag the mouse. 

To change the window size in two directions at once, move the cursor to a corner (rather than an edge) and press and hold down the left mouse button as you drag the mouse.

Try using these techniques to resize one of the windows on your screen several times. 

Moving Windows 

To move a window, put the cursor anywhere in the window's titlebar, then hold down the left mouse button and drag the window to its new location.

Try using the above technique to move one of the windows (for example, the UNIX or printerchooser window) to a new location on the screen.  Move the windows several times, to different locations, for practice.

Moving Windows in Front of or Behind Other Windows 

Since you can have many windows open simultaneously on your screen, you will often need to move windows in front of or behind other windows in order to type in the appropriate window.

Using each of the following methods, try to bring a window to the top of a pile of windows on the screen. You should have at least three windows open - for example, the RCS Applications menu window, the printerchooser window, and a UNIX window. You might have to move the windows around a bit to overlap them. 

First, try left-clicking in the titlebar of a window to bring that window to the top. Then, middle-click in the same titlebar to move that window to the bottom of the stack and bring all the other windows up one level. You can cycle through the windows several times this way.

Using Scroll Bars to View the Entire Contents of a Window

Some windows have scroll bars along the left or right side and/or the bottom. These bars allow you to view other parts of the contents of a window, when the entire contents will not fit in a single window. Unfortunately, scroll-bar style is not standardized, so you have to play with each package to see how the scroll bars for that package work. 

You will use scroll bars in this handout when you learn how to use Z-Mail and RPInfo. Use the left mouse button to click on the top and bottom arrows in the scroll bars. Also, try clicking in the empty space between the arrows, and on the filled-in rectangle in the scroll bar, called the scroll bubble or slider. Notice how these procedures differ.

   Glossary of Acronyms and Terms

ACS -- Academic Computing Services

CII -- Center for Industrial Innovation

CIS -- Computing & Information Services

DHCP -- Dynamic Host Configuration Protocol

DNS -- Domain Name Server

IP Address -- A unique set of numbers set to specify your PC's connection to the Internet

JEC -- Jonsson Engineering Center

LIS -- Libraries and Information Services

NIC -- Numerically Intensive Computing

RCR -- Rensselaer Computer Repair

RCS -- Rensselaer Computing System

RPInfo -- Rensselaer's campuswide information system

SIS -- Student Information System

VCC -- Voorhees Computing Center

WINS -- Windows Internet Name Service

WWW -- World Wide Web

Z-Mail -- Electronic mail program on the UNIX platform

   Useful URLs, E-Mail Addresses, and Phone Numbers

Academic Computing Services Homepage

http://www.rpi.edu/Computing/ACShome.html

Account Information


http://www.rpi.edu/Computing/Consulting/Accounts/Accounts.html

Ext. 7777 

Architecture Library Information

http://www.rpi.edu/dept/library/html/architecture/


Ext. 6465

Campus Computer Store

http://www.rpi.edu/dept/computer_store/

Ext. 8152

CIS Regular Computer Lab Hours


http://www.rpi.edu/Computing/Labs_maps/Hours/Hours.html

CIS Special Computer Lab Hours


http://www.rpi.edu/Computing/Labs_maps/holiday-hours.html

Class Reserve Information

http://www.lib.rpi.edu/dept/library/reserves/index.html

Computing Etiquette Information


http://www.rpi.edu/Computing /Ethics/ethics.html

Computer Equipment Repair


http://www.rpi.edu/dept/cis/rcr/RPInfo/


repair@rpi.edu


Ext. 8178

Consulting


consult@rpi.edu


Ext. 7777

Dial-In Modem Numbers


14.4k bps:

276-7989 

Up to 33.6K bps 
271-3800 (off-campus only) 

Up to 56K bps 

244-1500 (off-campus only)

Documentation


http://www.rpi.edu/Computing/Docs/docs.html

E-Mail Help and Information


http://www.rpi.edu/Computing/Consulting/Email/pm.html


postmaster@rpi.edu


Ext. 8281

Folsom Library Information


http://www.lib.rpi.edu/dept/library/html/LibInfo.html

General Campus (non-computer-related) Repairs


fixx@rpi.edu

Introductory Information for New Students


http://www.rpi.edu/Computing/Intro/welcome.html

IP Address Requests and Related Issues


hostmaster@rpi.edu

Kiosk Newsletter Subscription Requests


kiosk-subscribe@rpi.edu

Libraries' Homepage (RensSearch)


http://www.lib.rpi.edu/dept/library/html/LibInfo.html

Library PIN Help and Information


http://www.rpi.edu/dept/library/html/information/policies/pins.html

PC Labs and Available Software Listings


http://www.rpi.edu/dept/acs/pcinfo/pcinfo.html

Printing Information


http://www.rpi.edu/Computing/Consulting/Printing/printing.html

RPInfo Assistance


rpinfo_support@rpi.edu

Telecommunications Inquiries


telecom@rpi.edu


Ext. 6258
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